This PDF file contains the manuals for the following systems:

1. Webscan TruCheck™ USB
2. Webscan TruCheck™ USB Laser

Please click on the appropriate link for your system to view the manual for your system.
# Table of Contents

PRODUCT INFORMATION ................................................................................................................................. 1
1.1 Welcome! ................................................................................................................................................. 1
1.2 Package Contents...................................................................................................................................... 2

INSTALLATION INSTRUCTIONS ........................................................................................................ 3
2.1 Software Installation Instructions.............................................................................................................. 3
2.2 To install TruCheck USB Software .............................................................................................................. 4
2.3 Hardware Installation Instructions ............................................................................................................ 7
2.4 Using the Verifier for the First Time........................................................................................................... 9

USING THE TRUCHECK USB APPLICATION ................................................................................. 10
3.1 Introduction............................................................................................................................................. 10
3.2 User Interface Overview........................................................................................................................... 11
3.3 User Interface Details ............................................................................................................................... 12
  3.3.1 The File, Options and Help Menus ............................................................................................................... 12
  3.3.2 Icons Located on the User Interface ............................................................................................................ 13
3.4 System Setup using the Settings Menu ..................................................................................................... 15
  3.4.2 Details for the Settings Menu, 2D Context .................................................................................................. 18
  3.4.3 Details for the Settings Menu, 1D context ................................................................................................. 22

VERIFYING DATA MATRIX SYMBOLS ............................................................................................ 26
4.1 Introduction............................................................................................................................................. 26
4.2 How to verify a Data Matrix symbol ......................................................................................................... 27
4.3 Software Tab Selections ........................................................................................................................... 33
  4.4.1 The Data Matrix Report ............................................................................................................................ 38
  4.4.2 ISO 15415 Data Matrix Parameters ........................................................................................................... 39
  4.4.3 AS9132 Data Matrix Parameters ................................................................................................................. 44
  4.4.4 ISO 16022 Data Matrix Parameters ............................................................................................................. 45
  4.4.5 AIM-DPM 2006 Data Matrix Parameters ..................................................................................................... 45
  4.4.5 MIL-130 – UID Special Features .................................................................................................................. 47

VERIFYING LINEAR SYMBOLS ........................................................................................................ 48
5.1 Introduction ............................................................................................................................................. 48
5.2 Setting the scan region ............................................................................................................................. 49
5.3 How to verify a “RSS Composite” symbol with GS1 format checking ......................................................... 51
5.4 Scan Reflectivity Profile (SRP) ................................................................................................................. 54
  5.4.1 Interpreting the presented information ...................................................................................................... 55
Product Information

1.1 Welcome!

Congratulations on the purchase of your TruCheck™ USB verifier! With this system, you can reach a new level of quality assurance.

The Webscan TruCheck USB, CCD based barcode verifier, based on ANSI/ISO methodology, scans and verifies the print quality of 1D and 2D barcode symbols. Detailed reports of print quality are produced for printout or electronic archival.

The TruCheck USB system is as easy to use as it is powerful. The main features of the system are:

- Accurate barcode verification according to global standards
- CCD Imager with integrated illumination
- Repeatable results
- Calibrated and traceable to NIST standards
- Intuitive User Interface
- Detailed reporting
- Storage of verification results in Adobe PDF, HTML, MS Excel and CSV
- Easy to use
- Consistent results independent of operator training or skill

This manual will guide you in using the TruCheck USB verifier and in fully understanding the available features. Also, it will assist you in understanding the verification results shown on the display and printed reports.

*TruCheck is a trademark of Webscan Inc.*
1.2 Package Contents

Check the verifier package for the following items.

1. TruCheck USB CCD Imager

2. TruCheck USB User Interface Installation CD

3. Power Supply

4. Quick Set Up Sheet

5. GS1 Calibration Card (optional)

If any of the above items are missing please contact Webscan. (Contact information can be found in the “if you need service” section near the end of the manual.)
Installation Instructions

2.1 Software Installation Instructions

TruCheck USB installation program takes you through the installation with instructions on every screen.

Before installing TruCheck USB:

Close all other applications.

- Make sure the TruCheck USB hardware is not plugged into the computer.

  \textit{Note: If the TruCheck USB hardware is plugged in before, or during the software installation, the computer will install the TruCheck USB as an “unknown” device and it will not function.}

Log into your computer with administrator privileges if you are installing on Windows XP, vista or 7.

Make sure that the .NET framework version 3.5 is installed on the PC. If the framework is not installed on the PC, you can do so by browsing to the “dotNET Installer” folder on the CD and running “dotNet Installer v3.5” executable. Make sure and use the Windows Update function to check for upgrade information pertaining to the .NET framework.
2.2 To install TruCheck USB Software

Insert the TruCheck USB CD-ROM into the CD-ROM drive. The installation program should start automatically. If it does not start, locate your CD-ROM drive in Windows Explorer and double-click the Setup.exe program at the top-level of the CD-ROM.

If you get a message stating that the .NET framework runtimes are not installed, please either choose to download it from the Microsoft website or install it from the CD. To install from the CD, locate your CD-ROM drive in Windows Explorer and right-click on it, then choose “Open” and browse to the “dotNet Installer” folder. Double-click on the “dotNet Installer v3.5” icon to install the framework.

After installation of the .NET framework runtime completes, please proceed to the top-level of the CD-ROM and run the “Setup.exe” to install the TruCheck USB application.

Follow the on-screen prompts to complete the installation.

Click Next
Click Next

Click Next
Wait until the program has finished loading

Once the program has finished loading the hardware can be installed... follow the Hardware Installation instructions on the next page
2.3 Hardware Installation Instructions

*Note: The TruCheck USB software should already have been installed in accordance with the preceding section of this manual before plugging in the TruCheck USB hardware to the computer.*

The following information shows the proper setup procedures for your new TruCheck USB. Before proceeding, locate the remote and any accessories you purchased.

To install TruCheck USB Hardware:

Connect the USB remote camera directly to a USB port on the computer. The USB port on the computer must support USB 2.0.

Please connect the power supply to the verifier cable.

When prompted for the location of the drivers or any other files required during installation of the hardware drivers, please use the following folders: the “Drivers” folder on the CD or the path “C:\Program Files\Webscan Inc\TruCheckUSB\Drivers”

Follow the on-screen prompts to complete the hardware installation. Once the USB cable is attached to the computer you should see the “Found New Hardware” dialogue.
Choose Next

Path should be “C:\Program Files\Webscan Inc\TruCheckUSB\Drivers”
2.4 Using the Verifier for the First Time

Double-click the TruCheck USB icon on the Windows desktop or from “Start → All Programs → Webscan Inc → Webscan TruCheck USB”

As the software loads, the remote camera’s LED’s will flash once and the ON LED on top of the verifier will turn on.

Prior to using the verifier some initial set up should be done. Utilizing the Quick Start set up sheet you received with the verifier place the imager over the Data Matrix code and depress the button on the imager. You should see a live image of the code on your computer screen. If you do not see a live image, follow the troubleshooting tips on page 74. Position the imager such that the center of the code is aligned with the center of the image which is indicated by the target on the display and depress the button on the imager again to begin the verification.

Note: Positioning the verifier with the cable protruding away from you will aide in your movement of the imager in the live view, because the top of the image corresponds to cable end of the verifier

The system should tell you it has successfully set its pixel dimensions and prompt you to calibrate the verifier, follow the calibration instructions on page 69 using your Calibration card.

Select the appropriate options for your application using the “Settings” Menu (more details in section 3.4).

Your verifier should be ready to use.
Using the TruCheck USB Application

3.1 Introduction

The TruCheck USB user interface allows the user to control every aspect of the TruCheck USB verifier and create and save various reports. This portion of the manual will describe in detail the operation of the user interface.

The application can be started by double clicking the “Webscan TruCheckUSB” icon on the desktop or by going to “Start → All Program → Webscan Inc → Webscan TruCheckUSB”
3.2 User Interface Overview

The startup screen of the TruCheck USB user interface with a brief description of each object, details follow in the next section.
3.3 User Interface Details

3.3.1 The File, Options and Help Menus

- **File Menu**
  - **Print Report** – Allows the operator to select any printer in the Windows Printer Folder for printed reports.
  - **Print Strip Report** – Prints a report formatted to 40 columns to be printed to an attached thermal or dot matrix printer.
  - **User Password Options** – Allows the System Administrator to set Password Protection on the “Settings” and “Calibration” menus. In order to change the password, you need to enter the current password. The default password as shipped from Webscan is “user” (using lower case letters).
  - **Exit** – Used for an orderly shut down of the application.

- **Options**
  - **Settings** – Sets up the system for symbology, quality standards selection and reporting options. This menu is explained in detail in Section 3.4 of this Manual.
  - **Advanced Settings** – These settings are password protected, these settings should only be accessed when instructed by a technical support representative from Webscan.
  - **Calibrate Remote** – This is the Calibration menu, detailed Calibration instructions are in Chapter 7 of this Manual.
  - **Save Results to Excel™** - Selecting this option initiates a Microsoft Excel™ file to open and collect all subsequent verification results. The File is saved at the selected path set up in “Settings”. This process can also be initiated by clicking on the Excel Icon located on the User Interface. Detailed explanation of the setup and use of the Spreadsheet are in Chapter 6 of this Manual.

- **Help**
  - **Calibration Log** – A complete log of date and time the verifier has been calibrated.
  - **Debug Information** –
    - **Save Now** - Used to save a file of problematic codes for evaluation by Webscan. Select this option after the scan and save the file to a known location. This file can be emailed to Webscan for evaluation.
- **Save Before Verify** – Used to save a file of problematic codes for evaluation by Webscan, in cases where the verification process causes the software to crash, or otherwise prevents the saving debug information after the scan has taken place.

- **About** – Lists the current software revision.

- **Update** – If the PC that the verifier is connected to has internet access this option will initiate a check of more current software and download the software to the machine for installation. Details for upgrading software are in Chapter 8 of this manual.

### 3.3.2 Icons Located on the User Interface

- **Illumination Icons**

  These icons only pertain to the TruCheck USB-DPM Imager.

  **45Q Icon** – This icon selects 45 degree illumination. 45 degree four sided illumination is used primarily for labels and is the only option with the standard USB and Wide Angle imagers. This is the illumination needed for linear 1D and 2D barcode verification. This illumination is either not reported or is reported as 45Q. (If illumination is not reported it is assumed to be 45Q)

  ![45Q Icon](image)

  **30Q Icon** – This icon selects 30 degree illumination from four sides. It may reduce glare from some substrates which cause poor Symbol Contrast or Modulation grading. This illumination is reported as 30Q.

  ![30Q Icon](image)

  **30T Icons** – These icons select 30 degree two sided illumination. These are again for substrates causing issues with the 45Q illumination or on curved surfaces. This illumination can be either from the North/South or East/West. This illumination is reported as 30T.

  ![30T Icons](image)

  **90 Icon** – This icon selects 90 degree diffuse illumination and works well on very shinny substrates and Dot Peen Applications. It is reported as 90.

  ![90 Icon](image)
• **Diagnostic Icons**

**The Magnifier Icon** – The Magnifier enhances or enlarges the view of a decoded symbol. This is beneficial for examining problem areas of a symbol.

**The Grid Icon** – This either removes or overlays the barcode with a grid or scan lines. In the case of 2D symbols, the grid displays the intersections and apertures, yellow or red indicators, representing warning or failing sections of the barcode. For linear bar codes, this button will display yellow lines indicating where the 10 decoded scans happened to fall.

**The Original Icon** – This restores the original view of the barcode.

**The Black and White Icon** – This will display the image as an imager might see the barcode. The black and white image is the result of thresholding the blurred image with the global threshold. The black and white image is what is actually used for decoding.

**The Blurred Image Icon** – The blurred image represents the result of processing the original image with the verification aperture. Small defects such as spots and voids may be “filled in” by this processing, and edges will appear to be “softened”. This image is then used to calculate the global threshold, which is applied to the blurred image to get the black and white image.

**The Excel Icon** – This icon initiates the Excel spread sheet for capturing data from verification. Microsoft excel needs to be installed on the machine and the report path needs to be set in the Settings menu explained in detail in Chapter 7 of this manual.

**The Print Icon** – This icon will print the results of the last barcode verified to the Default Windows Printer.
3.4 System Setup using the Settings Menu

The following settings can be accessed through the “Options → Settings” menu selection.

Figure 3-1 – The settings dialog with 2D context selected.
3.4.1 Global Options

These options apply to both 1D and 2D verifications, and appear at the bottom of the settings dialog window regardless of which context – 1D or 2D – is selected.

- Report and Print Options
  - **Auto Print Report** – This option when selected will automatically print a report to the default Windows printer after all verifications. To change which printer is the default, select File → print report (3.3.1). In the list of installed printers, one will have a small black check mark indicating that it is the current default printer. Right click on the desired printer and select “set as default printer”.
  
  - **Metric Units** – This option would report nominal x-dimensions and other numeric information in metric instead of imperial units. The most noticeable change this makes is distances expressed as micro meters instead of mils.
  
  - **Strip Report Options** – This section includes options related to printing strip reports.
    
    ▪ **Strip Printer Type** – Options include Thermal which is normally associated with a 40 column thermal printer, or Dot Matrix. These printers are selected using the options described under File → Print Strip Report (3.3.1).
    
    ▪ **Auto print strip report** – This will automatically print a strip report to an installed thermal or dot matrix printer. Be sure to select the correct type of printer in the drop down box above this option.
  
  - **File Format** – This section presents options for which file types will be created in the Report Path (PDF, CSV, HTML, and TEXT). If multiple file types are selected, a file of each type will be created in the folder indicated by the report path, which appears to the right of the Save Report checkbox (pg. 17).

  *Note: The reports, even though selected, will not be automatically saved unless the “Save Report” option is selected. This option gives the operator the ability not to write reports with a single selection and without having to change the report types or paths. This is beneficial in the event of testing codes to alleviate print process issues where individual saved reports may not be desired.*

  - **Auto Prompt for Excel™** – This option enables exporting verification results to a Microsoft Excel™ spreadsheet. If no Excel™ spreadsheet is open at verification time, the system will ask to create and/or open one. Choosing “Yes” in this event has the same effect as pressing the Excel™ button in the main window (pg. 14): a new window appears in which there are options to manage new and existing spreadsheets. Once a spreadsheet is open, the system does not ask for any input after each verification, but automatically exports results to Excel™. Macros must be enabled in Excel™ for this feature to work properly. The spreadsheet can be closed
by clicking on the Excel™ button in the main window, and choosing “Close Job” in the window that appears.

- **Save Report** – This option enables automatic saving of reports in the selected formats and to the path selected to the right of this checkbox. This option’s selection has no effect if nothing is checked in the File Format section (pg. 16). This single selection could begin or end reporting without the need to reselect other report options. The path to which the file is saved is discussed in detail here:

  - **Save Report Path** – This is the path either on a local hard drive or on a network file server where selected reports are saved. These are automatically saved in one or any combination of the selected formats. (PDF, CSV, HTML, and/or TEXT) The user must have permission to write to the desired location, and the location must be selected by browsing to the location. The file saved has the following naming convention:

    `<Symbology><Date Time Stamp>-<Up to 40 chars of symbol data>`

    - If the symbol contains more than 40 characters, the last character printed in the filename is an ‘!’ indicating truncation.
    - Invalid filename characters are replaced by an underscore (‘_’).

- **Append Mode** – This option enables appending verification reports to one PDF file. To the right of this checkbox is the path where Appended PDF files will be saved. The path must include a valid Adobe PDF filename. The user must have write permissions on the selected file.

- **User Information** – Information provided in this section will appear in the beginning of verification reports.

  - **Company Name** – The company name entered here will appear on PDF verification reports.

  - **User Name** – The name entered here will be reported as the “Verified By” name in the beginning of the report. The user name appears on all reports.

  - **Batch #** – What is entered here will appear on PDF verification reports.

  - **Job #** – What is entered here will appear on PDF verification reports.

  - **Logo URL** – A URL can be entered here so that the logo of the company appears on PDF reports. The URL entered must be valid, and will be checked for validity on input. A notification will appear if the URL entered is invalid. The browse button can be used to find the needed image only if it is on the local machine (on the hard disk of the computer being used for verification), or on the local network. Otherwise, the URL must be typed or pasted (using Ctrl+V) into this field.
3.4.2 Details for the Settings Menu, 2D Context

- **Symbologies**
  
  Select the appropriate box for the type of symbol you are verifying. For best results, deselect all boxes for code types you are not verifying. If you are unsure what type of code you are trying to verify, see Appendix D.

- **Application Standards**
  
  This section contains options that allow checking various specific application standards. When one of these options is activated, a new field is displayed on the main tab after verification which displays the result of the chosen application standard. This field turns red if the chosen application standard failed, and green if it passed. This is useful for providing an at-a-glance acceptance or failure. This field does not appear when Pass Grade is chosen, and N/A is the pass grade selection.

  - **GS1** – This option activates data parsing to allow for checking the GS1 data format rules when the function 1 character is found. When GS1 is activated by clicking its radio button, the selections are: Always – to always check, and Auto – to check but not fail the code if the function 1 character is not found.

  - **MIL-130-STD UID** – This selection activates both MIL 130 and UID Format Check.

    - **MIL 130** provides, both in reports and on the user interface, an overall Pass or Fail based on the selection of Quality Standard (ISO-15415, AS-9132 or AIM-DPM) and Data Format (Construct and data qualifier) compared to the rules in the Military Standard MIL-STD-130. Reporting formats are set to accommodate the rules spelled out in the MIL Standard. See table 3.1 for more information regarding MIL standard settings.

    - **UID Format Check** provides data format checking in conjunction with the MIL-STD-130. The verifier will appropriately check and report Construct 1 and 2 and all allowed data formats. This option also parses the data in reports and in the Data Detail tab of the user interface. The system also creates a correct Unique Item Identification (UII) concatenated string in the report.

  - **Pass Grade** – Establishes the minimum acceptable grade for the user’s application. When not chosen, the system will use a default pass grade of C (2.0).

- **Decode/Process/Evaluation Options**

  - **Dot Peen** – Select this if you are verifying Dot Peened codes to enable the dot connecting “stick algorithm” specified in AIM-DPM.
- **Invert Image** – Select this option if you are verifying linear barcodes with inverse colors (Bars represented as spaces). This is not necessary for symbologies such as Data Matrix or QR Code because inverse colors are already valid for these symbologies.

- **Aperture** – This is the synthetic aperture size the system will use to process the raw image into the reference (blurred) image. The aperture can be selected with the drop down box or manually entered by typing an aperture size in ten thousands of an inch. For example a 6 mil aperture is set either by selecting it from the drop down by typing 60. Note that 6 mil aperture is required for verifying many linear barcodes, such as GS1-DataBar (RSS), so when Linear/RSS is selected, the aperture will automatically be set to 60. An aperture of 5 mil, or 50, is often used with Data Matrix. The correct aperture size to choose is always governed by an application standard.

  *Note: When using the AIM-DPM standard to verify Data Matrix code this setting is disregarded, and the range of apertures specified in Stick Min and Stick Max is used instead. These values should be set to the values in the AIM-DPM passing grade requirement which specifies a range of X dimensions. For example, the grade requirements of DPM 2.0/7.5-25/660/(45/30Q/30T/90) means that Stick Min should be set to 75 and Stick Max should be set to 250.*

- **X Dimension Range** – These are the adjustable Minimum and Maximum stick sizes the verifier will use when implementing the dot connecting “stick algorithm” while decoding when the Dot Peen option is selected. This also specifies the minimum and maximum aperture sizes to be used in AIM-DPM. These values are specified in ten thousandths of an inch, so 75 means 7.5 mil (a “mil” is one thousandth of an inch).

- **Avg. Angles** – This option allows averaging verification results of a Data Matrix Code at several angles of rotation.

### Grading Standards and Reporting Options

These are the selections which determine what Quality Standards and optional sections will print on the reports and display on the user interface. This section is largely organized by grading standards, however the first few options are not:

- **Traditional Parameters** – Includes Minimum Reflectance Difference (MRD) in the reported General Characteristics both in the verification report and on the user interface. MRD quantifies the minimum difference anywhere across the bar code. These worst case black and white modules need not be adjacent to one another.

- **Image of Symbol** – Puts the image used for verification on the verification report.

- **ASCII Values** – Turns on the reporting of the encoded ASCII values. Values are reported on printed and saved verification reports as well as in the Data Detail Tab.
All other reporting options are organized by grading standard. The following reporting options have the same meaning regardless of under which standard they appear:

- **Quality Parameters** – Enables reporting of a standard’s quality parameters and their corresponding values and grades. Selecting this is highly recommended as this information makes visible the reasons for poor results in a standard.

- **Mod Values** – Reports in the printed and saved reports the individual Modulation values from each data cell in the symbol. Modulation values can be viewed on the User Interface Mod Values Tab regardless of this selection.

- **Codewords** – Turns on reporting of the codewords when verifying symbols. Values are reported on printed and saved reports as well as in the Data Detail tab.

- **ECC Details** – Turns on reporting of error correction details, which appear within the General Characteristics.

- **Suppress on Fail** – In verification, if the symbol fails (grades below the pass grade of) the standard, and it passes another selected standard, then this standard’s results will not be included on the verification report. For example, if this option is set in the ISO 15415 standard options and both the ISO 15415 and AIM-DPM standards are enabled, and the ISO 15415 grade for the verification is below the pass grade while the AIM-DPM grade is at or above the pass grade, then the ISO 15415 standard results will not appear on the verification report.

Various grading standards are available:

- **ISO-15415** – Reports and Displays in accordance with International Standards Organization Barcode Quality test specification for 2 dimensional symbols. Selecting this standard allows for the selection of ISO 15415 reporting options:

- **AIM-DPM** – Select this if you want to utilize the AIM-DPM verification standard. This can be selected with or without the Dot Peen selection.

- **AS-9132** – Reports and Displays in accordance with the SAE AS9132 quality requirement standard for part marking Data Matrix code. See Table 3.1 for information pertaining to this standard. This option is only selectable when Data Matrix is chosen in the Symbologies.

  - **Cell Size Diagnostics** – Enables reporting detailed clock track information showing heights and widths for Data Matrix clock track elements.

- **AIM:ISS (ISO 16022:2000)** – Reports and Displays in accordance with the ISO-16022 Symbology and Quality Specification for Data Matrix code. See Table 3.1 for information pertaining to this standard. This option is only selectable when Data Matrix is chosen in the Symbologies.
<table>
<thead>
<tr>
<th>MIL Standard</th>
<th>Minimum Grade</th>
<th>Aperture</th>
<th>Exceptions</th>
<th>Minimum X-Dim</th>
<th>Maximum X-Dim</th>
<th>Standard</th>
</tr>
</thead>
<tbody>
<tr>
<td>MIL-130L</td>
<td>B</td>
<td>5mil</td>
<td>N/A</td>
<td>7.5 mil</td>
<td>15mil</td>
<td>ISO/IEC 16022</td>
</tr>
<tr>
<td>MIL-130L with change 1</td>
<td>B</td>
<td>5mil</td>
<td>N/A</td>
<td>7.5mil</td>
<td>15mil</td>
<td>ISO/IEC 15415</td>
</tr>
<tr>
<td>MIL-130M</td>
<td>B</td>
<td>5mil</td>
<td>SC=MOD=C</td>
<td>7.5mil</td>
<td>25mil</td>
<td>ISO/IEC 15415</td>
</tr>
<tr>
<td>MIL-130M with change 1</td>
<td>B</td>
<td>5mil</td>
<td>SC=MOD=C</td>
<td>7.5mil</td>
<td>25mil</td>
<td>ISO/IEC 15415</td>
</tr>
<tr>
<td>MIL-130N</td>
<td>B</td>
<td>5mil</td>
<td>SC=MOD=C</td>
<td>7.5mil</td>
<td>25mil</td>
<td>ISO/IEC 15415</td>
</tr>
</tbody>
</table>

**AIM DPM**

<table>
<thead>
<tr>
<th>MIL Standard</th>
<th>Minimum Grade</th>
<th>Aperture</th>
<th>Exceptions</th>
<th>Minimum X-Dim</th>
<th>Maximum X-Dim</th>
<th>Standard</th>
</tr>
</thead>
<tbody>
<tr>
<td>MIL-130L</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td>MIL-130L with change 1</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td>MIL-130M</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td>MIL-130M with change 1</td>
<td>C</td>
<td>7.5mil-25mil</td>
<td>7.5mil</td>
<td>25mil</td>
<td>ISO/IEC 15415</td>
<td></td>
</tr>
<tr>
<td>MIL-130N</td>
<td>C</td>
<td>7.5mil-25mil</td>
<td>7.5mil</td>
<td>25mil</td>
<td>ISO/IEC 15415</td>
<td></td>
</tr>
</tbody>
</table>

**AS 9132**

<table>
<thead>
<tr>
<th>MIL Standard</th>
<th>Minimum Grade</th>
<th>Aperture</th>
<th>Exceptions</th>
<th>Minimum X-Dim</th>
<th>Maximum X-Dim</th>
<th>Standard</th>
</tr>
</thead>
<tbody>
<tr>
<td>MIL-130L</td>
<td>According to AS9132</td>
<td>N/A</td>
<td>N/A</td>
<td>5mil but no less than 3mil</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td>MIL-130L with change 1</td>
<td>According to AS9132</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td>MIL-130M</td>
<td>According to AS9132</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td>MIL-130M with change 1</td>
<td>According to AS9132</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td>MIL-130N</td>
<td>According to AS9132</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
</tr>
</tbody>
</table>

Table 3-1

21
3.4.3 Details for the Settings Menu, 1D context

The following settings can be accessed through the “Options → Settings” and selecting the “1D (linear)” tab. Select the settings needed for your application or specific verification results.

- **Type of code**

  Select the appropriate box for the type of symbol you are verifying. For best results, deselect all boxes for code types you are not verifying.
• Application Standards
  
  o **GS1** - Turns on the detailed parsing of the GS1 data string, signaled by the presence of the function 1 character. This checks data against the GS1 data format rules. When GS1 is activated by clicking its radio button, the selections are: Always – to always check, and Auto – to check but not fail the code if the function 1 character is not found. The results of this appear in the printed and saved reports and in the “Data Detail” tab.
  
  o **Pass Grade** – Establishes the minimum acceptable grade for the user’s application. When activated, this displays a new field on the main screen that not only displays the grade, but turns red if the grade received is lower than the minimum set, and green if the grade is higher. This is useful for providing an at-a-glance acceptance or failure.
  
  o **HIBC** – Enables bar code data parsing in accordance with the Health Industry Bar Code Standard.

• Decode Options
  
  o **Aperture** - This is the synthetic aperture size the system will use to process the raw image into the reference (blurred) image. The aperture can be selected with the drop down box or manually entered by typing an aperture size in ten thousands of an inch. For example a 6 mil aperture is set either by selecting it from the drop down by typing 60. Note that 6 mil aperture is required for verifying many linear barcodes, such as GS1-DataBar (RSS), so when Linear/RSS is selected, the aperture will automatically be set to 60. The correct aperture size to choose is always governed by an application standard.
  
  o **Wavelength** – This setting relates only to the Laser USB system; it cannot be adjusted.
  
  o **Spot size** – This setting relates only to the Laser USB system; it cannot be adjusted.
  
  o **I25/ITF14** – Select “Standard I25” to evaluate per ANSI/ISO I25 standard, or “GS1 ITF14” to evaluate per the GS1 criteria.
  
  o **UPC Sup** – Used to evaluate UPC Supplemental symbol extensions. Options include none (default), Auto, 2-digit and 5-digit. Choose Auto to let the software decide, or one of the other options.
  
  o **Mode**

    • **Pre-Press Negative** – If this feature is set, the system will verify negatives such as films used to develop printing plates (white bars and black spaces).
- **Pre-Press Positive** – If this feature is set, the system will verify positives such as films used to develop printing plates (black bars and white spaces).

- **Invert Image** – This option interprets the scan as “light on dark”, and should only be used when printing a lightly colored symbol on a dark background.

  - **Linear Auto Detect** – This option eliminates the need for drawing red lines on an image when verifying a linear symbol with an imager (camera). This option enables the system to find and verify a bar code automatically. The bar code will be verified using the inspection zone – starting from 10% into the top of the bar code, and ending 10% into the bottom of the bar code. Note that this option is only available when using the USB imager (camera) and it is not available when using the Laser USB remote.

**Report Options**

These are the selections which determine what quality standards and optional sections will print on the reports and display on the user interface.

  - **ISO15415/6** – The symbology is evaluated against these ISO standards.

  - **Quality Parameters** – Enables reporting of the standard’s quality parameters and their corresponding values and grades. Selecting this is highly recommended as this information makes visible the reasons for poor results in a standard.

  - **Per Scan Results**

    This option enables reporting of results for each scan line.

    - **10 Scans Grid (letter)** – This turns on the letter grade reporting for each of the 9 ANSI parameters for each individual scan, expressing the result as a letter grade. The grade letters follow traditional scholastic systems with an ‘A’ being the highest and an ‘F’ the lowest grade.

    - **10 Scans Grid (value)** – This turns on the letter grade reporting for each individual scan, expressing the grade result as a value between 0 and 100 percent.

  - **Element Widths** – This setting enable reporting of the actual measured widths, and the deviation of the bars and spaces in the symbol, broken down by individual characters or codewords. This shows up on the “Advanced Detail” tab in the application.

  - **SRP** – This option will print on the reports the scan reflectance profile from linear one dimensional barcodes. The SRP can always be viewed for linear barcodes in the SRP tab regardless of this selection.
o **Image of Symbol** – This option will include an image of the verification symbol on the PDF report. This option is only available when using a USB imager (camera) and not a USB laser.

o **Codewords** – Turns on the reporting of the PDF codewords when verifying PDF or uPDF symbols. Values are reported on printed and saved reports as well as in the “Data Detail” tab.

o **ECC Details** – This turns on error correction reporting pertaining to PDF417 and uPDF.

o **Traditional Parameters** – Turns on the reporting of traditional parameter values on the PDF report. Traditional parameters will appear in other reports and in the user interface regardless of this option when they apply.
Verifying Data Matrix Symbols

4.1 Introduction

In the “Options → Settings” menu, “Data Matrix” should be selected as the code type. Place the TruCheck USB imager over the Data Matrix symbol, using the opening in the guide plate to be sure that the symbol is in the field of view. Press the “Go Live” button to display the red target (green target when utilizing the AIM-DPM Specification) in order to center the symbol in the field of view of the camera (see fig. 4.1).

![Application window showing the positioning of Data Matrix symbol under the imager](image-url)
4.2 How to verify a Data Matrix symbol

The symbol does not have to be oriented in any particular direction as the application can verify the symbols omni-directionally. Be sure to center the Data Matrix symbol such that it is approximately centered under the red or green target on the screen (see fig. 4.1). The entire Data Matrix symbol (including its “quiet zones”) must fit within the field of view of the imager. The field of view of the imager is smaller than the opening in the guide plate.

Click the ‘Verify Code’ button (see fig. 4.1) or the “Start” button on the imager to capture the image and verify the symbol.

After the verification is complete, the application window will show the symbol magnified with the actual grid overlay on the symbol along with the results of the verification.

The following results can be accessed by using the icons in the main screen of the software.

![Application window showing the verified 2D symbol with the reported data and the magnified image](image)

*Fig. 4.2.1 – Application window showing the verified 2D symbol with the reported data and the magnified image*
Fig. 4.2.2 – Application window showing the magnified image compared to fig. 4.1
Fig. 4.2.3 – Application window showing the original image compared to fig. 4.1
Fig. 4.2.4 – Application window showing the black and white magnified image

The black and white image is the result of thresholding the blurred image with the global threshold. The black and white image is used for decoding.
The blurred image represents the result of processing the original image with the verification aperture. Small defects such as spots and voids may be “filled in” by this processing, and edges will appear to be “softened”. This image is then used to calculate the global threshold, which is applied to the blurred image to get the black and white image.
Fig. 4.2.6 – *Application window showing the magnified image with the grid overlay on it*

The grid displays the result of the reference decode algorithm which located the centers of the modules. A circle is drawn at each grid intersection. The diameter of the circle that is drawn is equal to the size of the verification aperture. The color of the circle (green, yellow or red) represents the quality grade level given to that module based on its reflectance margin with respect to the global threshold. The circles are useful for diagnosing quality issues, for example if the circles are indicating failing grades in space modules it may be indicative of excessive bar width growth or grid errors may be present in the verified symbol.
4.3 Software Tab Selections

**Data Detail:** Displays the decoded data as a data string, ASCII Encodation and Data Matrix code words

![Fig. 4.3.1 – Application window showing the ‘Data Detail’ tab](image)

Any code words which were not decoded but were filled in with error correction are indicated with asterisks.
**General Characteristics:** Displays the characteristics of the Data Matrix symbol.

**Fig. 4.3.2 – Application window showing the ‘General Characteristics’ tab**

General Characteristics include overall matrix size, data size, total code words in the symbol and how many code words are data and error correction budget for this size symbol. Also reported here are how many code words were corrected by error correction and then how much percentage of error correction was used.

Horizontal and vertical bar width growth values are reported which is useful for printers interested in correcting over / under print issues. Image orientation is reported and is based on the color of the “L” pattern for the symbol. Individual cell size is reported as nominal x-dimension. Worst case data cell reflectance value is reported as “Contrast Uniformity” and can be found in the advanced tab at the location reported.

MRD and PCS are traditional measurements of symbol contrast. MRD (minimum reflectance difference) is the difference in reflectance of the least bright space and the brightest bar within a symbol. PCS is the percentage of the light background color (Rmax) that is manifest between the brightest space (Rmax) and darkest bar (Rmin) in a symbol, so \( PCS = \frac{(Rmax - Rmin)}{Rmax} \).
**Quality Detail:** Displays the quality parameters of the Data Matrix symbol.

![Application window showing the 'Quality Detail' tab](image)

The parameters underlying the overall grade for each of the selected grading standards are shown. Details of each of these parameters are given in section 4.4 of this manual.
Advanced Details: Displays advanced details (where applicable) of the Data Matrix symbol. These are the individual modulation values for each data cell.

![Advanced Details Table](image-url)

Fig. 4.3.4 – Application window showing the ‘Advanced Detail’ tab
**Histogram:** Provides a graphical representation of the frequency of occurrence of reflectivity values in each pixel on the overall symbol (top graph) and module centers (bottom graph).

*Fig. 4.3.5 – Application window showing the ‘Histogram’ tab*
4.4 The Data Matrix Report

![Image of Data Matrix]

**Webscan TruCheck™ USB Verification Report**  
*Thu 21-Oct-2010 05:07:39 PM*  
*Software Version: 2.04.04*

**Report Summary**

<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Symbology</td>
<td>DataMatrix</td>
</tr>
</tbody>
</table>

**Verification Grades**

<table>
<thead>
<tr>
<th>Standard</th>
<th>Grade</th>
<th>Aperture</th>
<th>Wavelength</th>
<th>Lighting</th>
<th>Formal Grade</th>
</tr>
</thead>
<tbody>
<tr>
<td>ISO15415</td>
<td>A (4.0)</td>
<td>05</td>
<td>660</td>
<td>45</td>
<td>4.0/05/660</td>
</tr>
<tr>
<td>AIM ISS Data Matrix (ISO/IEC 16022:2000)</td>
<td>A (4.0)</td>
<td>05</td>
<td>660</td>
<td>45</td>
<td>4.0/05/660</td>
</tr>
</tbody>
</table>

**General Characteristics**

- **Matrix Size**: 24x24 (Data: 20x20)
- **Horizontal ERR**: 12%
- **Vertical ERR**: 15%
- **Encoded characters**: 44
- **Total Codewords**: 60
- **Data Codewords**: 38
- **Error Correction Budget**: 24
- **Errors Corrected**: 0
- **Error Capacity Used**: 0
- **Error Correction Type**: ECC 200
- **Image**: Black on white
- **Nominal X Dim**: 14.4 mil
- **Contrast Uniformity**: 54 at modulus (6.18)


- **1. DOD**: A, PASS
- **2. SC**: 80%, A, PASS
- **3. ERR**: 2%, A, PASS
- **4. ANU**: 0%, A, PASS
- **5. UEC**: 100%, A, PASS
- **6. RGB**: A, PASS
- **7. LLS**: A, PASS
- **8. RGB**: A, PASS
- **9. NQZ**: A, PASS
- **10. BQZ**: A, PASS
- **11. OQZ**: A, PASS
- **12. ROZ**: A, PASS
- **13. TRR**: 0%, A, PASS
- **14. RTR**: 0%, A, PASS
- **15. TOT**: A, PASS
- **16. RCT**: A, PASS
- **17. AG**: 4.0, A, PASS
- **18. DECODE**: A, PASS

**ASCII Values**

```
70 71 72 73 74 75 76 77 78 79 7a 7b 7c 7d 7e 7f 80 81 82 83 84 85 86 87 88 89 8a 8b 8c 8d 8e 8f 90 91 92 93 94 95 96 97 98 99 9a 9b 9c 9d 9e 9f a0 a1 a2 a3 a4 a5 a6 a7 a8 a9 aa ab ac ad ae af b0 b1 b2 b3 b4 b5 b6 b7 b8 b9 ba bb bc bd be bf c0 c1 c2 c3 c4 c5 c6 c7 c8 c9 ca cb cc cd ce cf d0 d1 d2 d3 d4 d5 d6 d7 d8 d9 da db dc dd de df e0 e1 e2 e3 e4 e5 e6 e7 e8 e9 ea eb ec ed ee ef f0 f1 f2 f3 f4 f5 f6 f7 f8 f9 fa fb fc fd fe ff
```

*Fixed by Error Correction

**Fig. 4.4.1 – The Data Matrix Report**
4.4.1 ISO 15415 Data Matrix Parameters

1. **UEC (Unused Error Correction):** This is the percentage of error correction capability that is available for further incorrect modules. The assignment of grade is according to the following table:

<table>
<thead>
<tr>
<th>UEC %</th>
<th>Grade</th>
</tr>
</thead>
<tbody>
<tr>
<td>&gt; 62</td>
<td>A</td>
</tr>
<tr>
<td>&gt; 50 (but less than 62)</td>
<td>B</td>
</tr>
<tr>
<td>&gt; 37 (but less than 50)</td>
<td>C</td>
</tr>
<tr>
<td>&gt; 25 (but less than 37)</td>
<td>D</td>
</tr>
<tr>
<td>&lt; 25</td>
<td>F</td>
</tr>
</tbody>
</table>

2. **SC (Symbol Contrast):** This is the difference in reflectivity between the brightest module and the darkest module. The assignment of grade is according to the following table:

<table>
<thead>
<tr>
<th>SC %</th>
<th>Grade</th>
</tr>
</thead>
<tbody>
<tr>
<td>&gt; 70</td>
<td>A</td>
</tr>
<tr>
<td>&gt; 55 (but less than 70)</td>
<td>B</td>
</tr>
<tr>
<td>&gt; 40 (but less than 55)</td>
<td>C</td>
</tr>
<tr>
<td>&gt; 20 (but less than 40)</td>
<td>D</td>
</tr>
<tr>
<td>&lt; 20</td>
<td>F</td>
</tr>
</tbody>
</table>

3. **MOD and RM (Modulation):** This is a grade based on the amount of variability in reflectivity of the modules. A multi-step process is used to get the modulation grade. First the reflectivity of each module is compared to the global threshold and the overall Symbol Contrast according to the following formula:

\[ \text{MOD} = 2 \times \frac{\text{abs}(R - \text{GT})}{\text{SC}} \]

The Global Threshold GT is the midpoint between the reflectance of the brightest module and the reflectance of the darkest module. Next, the grade level for each module is determined from the MOD value according to the following table:

<table>
<thead>
<tr>
<th>MOD %</th>
<th>Grade</th>
</tr>
</thead>
<tbody>
<tr>
<td>&gt; 50</td>
<td>A</td>
</tr>
<tr>
<td>&gt; 40 (but less than 60)</td>
<td>B</td>
</tr>
<tr>
<td>&gt; 30 (but less than 50)</td>
<td>C</td>
</tr>
<tr>
<td>&gt; 20 (but less than 30)</td>
<td>D</td>
</tr>
<tr>
<td>&lt; 20</td>
<td>F</td>
</tr>
</tbody>
</table>

Finally, the value of the grade for the MOD parameter will be the highest modulation level for which the modules meeting that level will result in an Unused Error Correction grade of that level or higher.
4. **ANU (Axial Non-uniformity):** This is the amount of “out of square” a symbol is, or in other words a measure of the overall aspect ratio of the symbol.

<table>
<thead>
<tr>
<th>ANU %</th>
<th>Grade</th>
</tr>
</thead>
<tbody>
<tr>
<td>( \leq 6 )</td>
<td>A</td>
</tr>
<tr>
<td>&lt; 8 (but more than 6)</td>
<td>B</td>
</tr>
<tr>
<td>&lt; 10 (but less than 8)</td>
<td>C</td>
</tr>
<tr>
<td>&lt; 12 (but less than 10)</td>
<td>D</td>
</tr>
<tr>
<td>&gt; 12</td>
<td>F</td>
</tr>
</tbody>
</table>

5. **GNU (Grid Non-uniformity):** This is the worst case distance between the calculated center of a module and the ideal location for the center of the module based on perfectly evenly spaced modules. The calculated center of the module is determined using the clock tracks. The value is reported as a percentage of a module size.

<table>
<thead>
<tr>
<th>GNU %</th>
<th>Grade</th>
</tr>
</thead>
<tbody>
<tr>
<td>( \leq 38 )</td>
<td>A</td>
</tr>
<tr>
<td>&lt; 50 (but less than 38)</td>
<td>B</td>
</tr>
<tr>
<td>&lt; 63 (but less than 50)</td>
<td>C</td>
</tr>
<tr>
<td>&lt; 75 (but less than 63)</td>
<td>D</td>
</tr>
<tr>
<td>&gt; 75</td>
<td>F</td>
</tr>
</tbody>
</table>

6. **FPD (Finder Pattern Damage):** This is the overall grade for all the finder pattern components. This grade is equal to the lowest grade of all the components listed below. The following is a list of components of the finder pattern.

7. **LLS (Left ‘L’ Side):** This is a grade based on imperfections in the left ‘L’ side of the finder pattern. There are two checks required to pass. The first requires gaps to be three modules or less and that gaps are separated by stretches of at least four correct modules. The second assigns a grade based on the overall percentage of correct modules according to the following table:

<table>
<thead>
<tr>
<th>% of incorrect modules</th>
<th>Grade</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>A</td>
</tr>
<tr>
<td>&lt; 9 (but more than 0)</td>
<td>B</td>
</tr>
<tr>
<td>&lt; 13 (but more than 9)</td>
<td>C</td>
</tr>
<tr>
<td>&lt; 17 (but more than 13)</td>
<td>D</td>
</tr>
<tr>
<td>&gt; 17</td>
<td>F</td>
</tr>
</tbody>
</table>

The grade is the highest modulation level in which the first (gap test) passes and the correct module percentage results in a grade of that level or higher.

8. **BLS (Bottom ‘L’ Side):** This is a grade based on imperfections in the bottom ‘L’ side of the finder pattern (see Left ‘L’ Side).

9. **LQZ (Left Quiet Zone):** This is a grade based on imperfections in the quiet zone, which is a one module area to the left of the left ‘L’ side. The grade is based on the percentage of modules which are correct using the same grading table as for the ‘L’ sides.
10. **BQZ (Bottom Quiet Zone):** This is a grade based on imperfections in the quiet zone which is a one module area below the bottom ‘L’ side.

11. **TQZ (Top Quiet Zone):** This is a grade based on imperfections in the quiet zone which is a one module area above the top clock track.

   a. **ULQZ (Upper Left Quiet Zone):** This is the top quiet zone above the upper left quadrant (Used only for 2 and 4 quadrant symbols, this is the grade based on the segment of the quiet zone above the top clock track of the left quadrant).

   b. **URQZ (Upper Right Quiet Zone):** This is the top quiet zone above the upper right quadrant (Used only for 2 and 4 quadrant symbols, this is the grade based on the segment of the quiet zone above the top clock track of the right quadrant).

12. **RQZ (Right Quiet Zone):** This is a grade based on imperfections in the quiet zone which is a one module area to the right of the Right Clock Track.

   a. **RUQZ (Right Quiet Zone to the right of the upper right quadrant):** Only for 2 and 4 quadrant symbols, this is the grade based on the segment of the quiet zone to the right of the upper right quadrant.

   b. **RLQZ (Right Quiet Zone to the right of the lower right quadrant):** Only for 4 quadrant symbols, this is the grade based on the segment of the quiet zone to the right of the lower left quadrant.

13. **TTR (Top Transition Ratio):** This is a grade based on imperfections in the top clock track, with relation to its adjoining quiet zone. The ratio is the number of transitions, from light to dark or dark to light, in the quiet zone divided by the number of transitions in the clock track. Since the number of transitions in the quiet zone should be zero, the ideal value for this parameter is zero. However a small number of transitions can be tolerated as long as the ration remains relatively low. As the number of teeth in the clock track increases (larger symbols) more transitions in the quiet zone can be tolerated. Also, more transitions in the clock track (which are really imperfections) will tend to improve this measurement. The grading scheme for this transition ratio is:

<table>
<thead>
<tr>
<th>Transition Ratio %</th>
<th>Grade</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt; 6</td>
<td>A</td>
</tr>
<tr>
<td>&lt; 8 (but more than 6)</td>
<td>B</td>
</tr>
<tr>
<td>&lt; 10 (but more than 8)</td>
<td>C</td>
</tr>
<tr>
<td>&lt; 12 (but more than 10)</td>
<td>D</td>
</tr>
<tr>
<td>&gt; 12</td>
<td>F</td>
</tr>
</tbody>
</table>

The value of the grade will be the highest modulation level for which the ratio gives a grade from the above table of that modulation level or higher.

   a. **ULQTTR (Transition ratio for Upper Left Quadrant Top Clock Track):** Only for 4 quadrant symbols, this is the grade based on the clock track segment at the top of the upper left quadrant. For a 2 quadrant symbol, this will be labeled LQTTR.
b. **URQTTR (Transition ratio for Upper Right Quadrant Top Clock Track)**: Only for 4 quadrant symbols, this is the grade based on the clock track segment at the top of the upper right quadrant. For a 2 quadrant symbol this will be labeled RQTTR.

c. **LLQTTR (Transition ratio for Lower Left Quadrant Top Clock Track)**: Only for 4 quadrant symbols, this is the grade based on the clock track segment at the top of the lower left quadrant.

d. **LRQTTR (Transition ratio for Lower Right Quadrant Top Clock Track)**: Only for 2 and 4 quadrant symbols, this is the grade based on the clock track segment at the top of the lower right quadrant.

14. **RTR (Right Transition Ratio)**: Transition ratio (see Top Transition Ratio) for the right clock track in relation to the right quiet zone.

   a. **ULQRTR (Transition ratio for Upper Left Quadrant Right Clock Track)**: Only for 2 and 4 quadrant symbols, this is the grade based on the clock track segment to the right of the upper left quadrant. For a 2 quadrant symbol this will be labeled LQRTR.

   b. **URQRTR (Transition ratio for Upper Right Quadrant Right Clock Track)**: Only for 2 and 4 quadrant symbols, this is the grade based on the clock track segment to the right of the upper right quadrant. For 2 quadrant symbols this will be labeled RQRTR.

   c. **LLQRTR (Transition ratio for Lower Left Quadrant Right Clock Track)**: Only for 4 quadrant symbols, this is the grade based on the clock track segment to the right of the lower left quadrant.

   d. **LRQRTR (Transition ratio for Lower Right Quadrant Right Clock Track)**: Only for 4 quadrant symbols, this is the grade based on the clock track segment to the right of the lower right quadrant.

15. **TCT (Top Clock Track)**: This is a grade based on imperfections in the top clock track. Some imperfections in the clock track can be tolerated. However, the rule that must be maintained for a passing grade is that three out of every five modules (on a consecutively rolling window of five modules) must be correct. The value of the grade will be the highest modulation level for which this test passes.

   a. **ULQTCT (Top Clock Track for Upper Left Quadrant)**: Only for 2 and 4 quadrant symbols, this is the grade based on the clock track segment at the top of the upper left quadrant. For 2 quadrant symbols this will be labeled LQTCT.

   b. **URQTCT (Top Clock Track for Upper Right Quadrant)**: Only for 2 and 4 quadrant symbols, this is the grade based on the clock track segment at the top of the upper right quadrant. For 2 quadrant symbols this will be labeled RQTCT.

   c. **LLQTCT (Top Clock Track for Lower Left Quadrant)**: Only for 4 quadrant symbols, this is the grade based on the clock track segment at the top of the lower left quadrant.
d. **LRQTCT (Top Clock Track for Lower Right Quadrant):** Only for 4 quadrant symbols, this is the grade based on the clock track segment at the top of the lower right quadrant.

16. **RCT (Right Clock Track):** This is a grade based on imperfection in the right clock track (see Top Clock Track).

   a. **ULQRCT (Right Clock Track for Upper Left Quadrant):** Only for 2 and 4 quadrant symbols, this is the grade based on the clock track segment to the right of the upper left quadrant. For 2 quadrant symbols this will be labeled LQRCT.

   b. **URQRCT (Right Clock Track for Upper Right Quadrant):** Only for 2 and 4 quadrant symbols, this is the grade based on the clock track segment to the right of the upper right quadrant. For 2 quadrant symbols this will be labeled RQRCT.

   c. **LLQRCT (Right Clock Track for Lower Left Quadrant):** Only for 4 quadrant symbols, this is the grade based on the clock track segment to the right of the lower left quadrant.

   d. **LRQRCT (Right Clock Track for Lower Right Quadrant):** Only for 4 quadrant symbols, this is the grade based on the clock track segment to the right of the lower right quadrant.

17. **AG (Average Grade of Damage across many parts of the Finder Pattern):** This is a grade that considers the accumulated affect of damage to several parts of the finder pattern. Five values are averaged together. One of these is the lowest of all the grades associated with all the clock track segments, namely TCT, TTR, TQZ and RCT, RTR, RQZ. The other four are LLS, BLS, LQZ, and BQZ. The average must fall in the range of 0.0 through 4.0 and is given a grade according to the following:

<table>
<thead>
<tr>
<th>Ave Grade</th>
<th>Grade</th>
</tr>
</thead>
<tbody>
<tr>
<td>Equals 4.0</td>
<td>A</td>
</tr>
<tr>
<td>≥ 3.5 (but less than 4.0)</td>
<td>B</td>
</tr>
<tr>
<td>≥ 3.0 (but less than 3.5)</td>
<td>C</td>
</tr>
<tr>
<td>≥ 2.5 (but less than 3.0)</td>
<td>D</td>
</tr>
<tr>
<td>&lt; 2.5</td>
<td>F</td>
</tr>
</tbody>
</table>

*Note: The effect of the AG parameter is to lower the overall grade of symbols which have several individual parameters at or near the same level. For instance, with enough B grades in individual parameters the overall grade may come out as a C grade rather than a B.*
4.4.2 AS9132 Data Matrix Parameters

1. **Distortion Angle (DA):** The angle between the left side and the bottom side of the ‘L’ finder pattern should be 90 degrees. The distortion angle is the deviation from 90 degrees exhibited by the ‘L’ in this symbol. A distortion angle of 7 degrees or less will pass, while a larger distortion angle will fail.

2. **Cell Fill (Size):** The size of the cells must be printed at least 60% of the cell spacing, and no more than 105% of the cell spacing.

3. **Ovality:** For dot peen symbols (where the cells are allowed to be round) the cells should be circular. As a measure of ovality, the ratio of the widest diameter to the smallest diameter is checked and must be less than 20% different in order to Pass.

4. **Center Offset:** The center of each cell must not be offset from its correct grid location by more than 20% of the cell spacing in order to Pass.

5. **Symbol Contrast:** Symbol contrast should be at least 20% to Pass.

<table>
<thead>
<tr>
<th>AS9132 Quality Parameters</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>DA(Degrees)</td>
<td>0.44</td>
<td>Pass</td>
</tr>
<tr>
<td>Symbol Contrast</td>
<td>88%</td>
<td>PASS</td>
</tr>
<tr>
<td>Total Modules</td>
<td>484</td>
<td></td>
</tr>
<tr>
<td>Total Modules failed</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>Total Modules failed</td>
<td>0.4%</td>
<td>PASS</td>
</tr>
<tr>
<td>Size failed</td>
<td>0.4%</td>
<td></td>
</tr>
</tbody>
</table>
4.4.3 ISO 16022 Data Matrix Parameters

<table>
<thead>
<tr>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1. DCD</td>
</tr>
<tr>
<td>2. SC</td>
</tr>
<tr>
<td>3. BWG</td>
</tr>
<tr>
<td>4. ANU</td>
</tr>
<tr>
<td>5. UEC</td>
</tr>
</tbody>
</table>

ISO 16022 Parameters:
- Decode (DCD), Symbol Contrast (SC), Bar Width Growth (BWG), Axial Non-Uniformity (ANU), Unused Error Correction (UEC)

4.4.4 AIM-DPM 2006 Data Matrix Parameters

The AIM-DPM method of grading data matrix symbols modifies the process of ISO-15415 and is more appropriate for direct part marking applications. This standard was developed to be a more representative of the scanning performance of modern readers which in some cases are specifically designed for these demanding applications.

In this method, the image brightness is adjusted to produce an image of the symbol that fills most or all of the dynamic range of the imager, resulting in an image that is easier to see. Additionally, the threshold between dark and light is calculated from the statistics of the image brightness histogram. Thus the measurements calculated by AIM-DPM differ from those of ISO 15415 significantly.

Some of the parameters reported in ISO 15415 are changed so drastically, in order to remove the possibility of confusion between these two methods, the parameters have been renamed. These parameters are:

<table>
<thead>
<tr>
<th>AIM-DPM Parameter Name</th>
<th>ISO 15415 Parameter Name</th>
<th>Summary of Change(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>CC (Cell Contrast)</td>
<td>SC (Symbol Contrast)</td>
<td>Made relative to light background</td>
</tr>
<tr>
<td>CM (Cell Modulation)</td>
<td>MOD (Modulation)</td>
<td>Threshold calculated from statistics, rather than the maximum and minimum reflectance. Grading scale range set to Mean of distribution, rather than maximum and minimum reflectance</td>
</tr>
<tr>
<td>DD (Distributed Damage)</td>
<td>AG (Average Grade)</td>
<td>Modulation overlay uses only A, B and F levels instead of A, B, C, D and F.</td>
</tr>
<tr>
<td>MR (Minimum Reflectance)</td>
<td>Not necessary since SC is measured on an absolute scale</td>
<td>An absolute limit on SC of 5% added to temper the relative nature of CC.</td>
</tr>
</tbody>
</table>
All of the Fixed Pattern Damage grading (other than AG shown above) are not renamed, but are functionally different since the global threshold and modulation grading scale are different. In general, symbols will obtain a significantly higher grade according to AIM-DPM than ISO 15415. Therefore, grading according to AIM-DPM is appropriate only when called for in an application specification.

Another significant difference is the allowance for a variety of illumination options. These include the four sided 45° light that is the default for ISO 15415. Additionally allowed are: 30° lighting from four sides, 30° from two sides (which can be either North/South or East/West), and 90° diffuse on-axis lighting. The light source that is used is reported using a notation that includes the angle, and a letter (Q for 4, T for two.

AIM-DPM also varies the size of the aperture until the symbol is decoded, and then the grading is repeated with two different aperture sizes (50% and 80%) and the better of the two grades is reported as the final grade.

The parameters which are new or significantly modified for AIM-DPM are explained below:

1. **CC (Cell Contrast):** This is the relative contrast value between bars and spaces, taken from the means of the light and dark element, CC = (Lmean - Dmean) / Lmean.

<table>
<thead>
<tr>
<th>CC %</th>
<th>Grade</th>
</tr>
</thead>
<tbody>
<tr>
<td>≥ 30%</td>
<td>4</td>
</tr>
<tr>
<td>≥ 25%</td>
<td>3</td>
</tr>
<tr>
<td>≥ 20%</td>
<td>2</td>
</tr>
<tr>
<td>≥ 15%</td>
<td>1</td>
</tr>
<tr>
<td>&lt; 15%</td>
<td>0</td>
</tr>
</tbody>
</table>

2. **CMOD (Cell Modulation):** Similar to MOD in ISO 15415, this parameter measures the deviation in the reflectivity of dark and light elements. A range for each group (light and dark) is created from the global threshold to the mean reflectance of the elements. Each module is graded along this range, and then error correction capability is considered to “discount” the effect of one or a few elements with low values, and a final grade for this parameter is computed.

3. **DDG (Distributed Damage Grade):** Similar to AG in ISO 15415, this parameter takes into account the effect of multiple segments of the fixed pattern having imperfections. Where multiple segments have a low grade, the effect of this “distributed damage” is reflected in a lower grade for DDG than the lowest of the individual segments.

4. **MR (Minimum Reflectance):** This is a requirement for at least 5% reflectance difference between light and dark elements, as a restraint on the purely relative CC parameter.

5. **Decode:** Decode grade A or F depending upon whether the reference decode algorithm succeeds in decoding the symbol with the required final aperture size.
4.4.5 MIL-130 – UID Special Features

This report shows the UID data, with explicit parsing of the Data Identifiers (DI’s) and the syntax formatting characters (GS, RS, EOT, etc.) that are required according to ISO 15434. The Construct of the data is reported as well as the UII (Unique Item Identifier).
Verifying Linear Symbols

5.1 Introduction

Press the “1D” button to switch the camera to 1D context. Press the 1D button again to adjust settings related to the verification of a 1D symbol. A 6 Mil aperture is standard for most linear symbols. If your specific application requires a different aperture adjust the aperture setting to the required aperture.

Place the camera remote over the symbol so that the symbol to be verified is centered and level in the opening of the guide plate.

Fig 5.1 – UPC symbol centered in the cutout in the guide plate.
Note that the symbol must be properly aligned in order to be verified. It is important that the symbol is centered within the sweep of the laser. This can be best accomplished by using the notches in the guide plate opening as a reference.

Once the symbol is level, and centered in the field of view, the scan region lines must be established.

## 5.2 Setting the scan region

Press the “Go Live” button to display the red target. Utilize the target to center the barcode in the field of view of the camera with the top edge of the symbol aligned with the top edges of the image area minimizing any tilt (see fig. 5.1).

If the symbol to be verified is of a stacked symbology type, (if you are not sure if your symbol qualifies as “stacked”, see appendix D) click just above the top of the symbol, and drag downward releasing just below the bottom. You will see two dotted red lines, and each should be slightly outside the symbol.

If the symbol to be verified is of a non-stacked symbology type, click just below the top of the symbol, and drag downward releasing just above the bottom. You will see two dotted red lines, and each should be slightly inside the symbol. The gap between these two lines establishes the area to be evaluated by the verifier. It is important that these top and bottom lines fit cleanly inside the symbol. If they do not, the verifier will report a “no decode” for any of the lines that were not completely inside the symbol. This can cause a poor grade to be reported on a well printed symbol. See below for an example of properly defined begin and end lines for stacked and non-stacked symbols.

Note that the scan region can only be adjusted when the camera is in live mode.

---

Non-stacked symbol

stacked symbol

---

Once the region has been defined, press “verify Code” to begin the verification process.
Fig 4.2 – a UPC symbol with a properly defined scan region.
5.3 How to verify a “RSS Composite” symbol with GS1 format checking

To enable GS1 data format checking select “Auto” or “Always” in the “Options → Settings” menu under the “Decode Options”. Since, the RSS symbology does not require a FUNC1 character to denote the data as GS1 compliant, both the “Auto” and the “Always” options will check for a valid data format within the symbol verified.

![Fig 5.2.2 – Application window with a RSS composite symbol after verification with GS1 format checking](image)

When a RSS symbol is verified with GS1 format checking turned on, the data is parsed and each data component is passed or failed based on those rules. In order to obtain a passing grade for the “GS1 Acceptance Criteria”, both the data and symbol quality must meet the criteria set by GS1.
The “Data Detail” tab shows further details of the parsed data and any failures are reported on this tab. This comes in handy when troubleshooting issues with “GS1 Acceptance Criteria” failures.

![Application window showing the “Data Detail” tab along with data parsing information](image)

The parsed data is tabulated to show the data in the field, what the data denotes and whether the field passes or fails according to the rules set forth by GS1 for the specific AI’s and their data content.
The “Quality Detail” tab for linear one and two dimensional symbols shows the 9 ANSI parameters for each of the scans used to calculate the verification grade for the symbol.

Fig 5.2.3 – Application window showing the “Quality Detail” tab
5.4 Scan Reflectivity Profile (SRP)

After clicking “Verify Code” a series of yellow lines are presented on the symbol image under the “Main” tab. To view the SRP for any line, hover the mouse pointer over or near the line of interest and double left click it.

The line closest to the mouse cursor is selected. Using this method, the application will automatically switch to the SRP tab control window, and present details for the selected scan line.

The SRP page can also be viewed by selecting the tab control directly. In this mode, the default profile presented is the scan with the best grade closest to the center of the scanned lines for a symbol row. On a stacked symbology, where more than ten scan lines are presented, a profile meeting the conditions described above and from the primary row is presented. If an SRP has been previously selected, and another tab is viewed, the same SRP is presented on return.

Fig 5.3.1 – Application window showing scan lines (in yellow) used to verify the symbol
After entering the SRP page, use the mouse wheel or the vertical scroll bar to view any available scan profile. To return to the “Main” tab, double left click anywhere within the SRP tab control window. Other tabs may be selected for viewing at any time as desired.

5.4.1 Interpreting the presented information

Under normal circumstances, when only one SRP view is presented, the control window presents a variety of information.

The first image represents the scan as captured by the camera, directly beneath it is the black and white representation of this data. This representation is shown only if the current scan was successfully decoded.
The following is a list of the information presented on the SRP graphic:

- **Index**
  The value listed is always between 1 and 10. It is a sequential listing of the sampled scan lines associated with a given symbol. In cases where there are stacked symbologies, these values repeat for each symbol row evaluated. These values correspond to those indexed and listed under the “Quality Detail” tab.

- **Scan**
  The first numeric value is a scan index and increments for each scan evaluated by TruCheckUSB. It differs from the ‘Index’ described above in that it is the absolute scan number not relative to the symbol component. The next numeric value listed represents the actual scan line from the imager. In a stacked symbology, the sequencing based solely on the index values described above is not always apparent. This value can be used to correlate relative position of the yellow lines shown on the image under the “Main” tab. The value listed here is always sequential top to bottom.

- **Grade**
  The overall grade given a profile. This grade corresponds to the grade listed under the tab “Quality Detail”. In a case where the scan did not decode, this parameter will reflect “n/a”.

- **Reflectivity Scale**
  A green dashed line beneath the B&W view represents 100% reflectivity. A second green dashed line at the bottom of the image space represents 0% reflectivity. These lines are based on the black and white reflectivity measurements taken from the calibration card and its corresponding calibrated values.

- **Global Threshold**
  The white line between the green reflectivity scale lines represents a global threshold. This line represents the average reflectivity of the symbol under test. In general it is a good approximation of the threshold used to determine where the digital transition takes place as the SRP crosses it. This is reflected in the B&W representation discussed above. The global threshold value is indicated in green in the left margin.

- **SRP**
  The analog signal normally represented in blue is just another way of viewing the camera image displayed at the top of the control. It is a representation of the sequential pixel values captured by the camera. The SRP may also include segments that are colored differently. The colors indicate an element within the SRP that resulted in a grade contribution that was less than an ‘A’. The color codes are as follows, A – blue, B – green, C – yellow, D – orange and F – red.
A tooltip will popup if the mouse is hovered over a colored element. The tooltip will indicate a reason code, its grade, and measured value. In the example above, the tooltip indicates element #29 has a defect that measured 20, and received a 'B' grade. The reason codes listed under the “Quality Detail” tab for each profile will reflect the worst grade for a parameter in the scan. In some cases the tool tip balloon box may list more than one reason code. In addition the same reason code may be displayed by multiple elements, the worst being the one listed under the “Quality Detail” tab.
• **Advanced Option Horizontal Zoom**

In some cases, more detail may be desired. To zoom in on a problem element(s), position the mouse cursor at a start location, click the left button and while holding it, drag to an end position. As the mouse is dragged, a brown dashed line will appear indicating the area being zoomed. Upon release of the left mouse button, the control is redrawn showing only the area previously selected. To further improve resolution, maximize the application window. To return to a normal view left click one time anywhere within the control window.
Index: 15
Scan: 15 [485]
Grade: 'B'

100%

37%

0%
• **Advanced Option Multiple SRP select**

In some cases the user may want to compare one or more SRP’s of sequential profiles, for instance in a case where a defect is running through multiple scan lines. In this scenario the sequential SRP’s will all show the same element highlighted.

To select a group, first right click one time in the SRP control window. This will result in a view showing all available SRP’s.

In this window, position the mouse cursor just above the first SRP of interest, click and hold the left mouse button and drag to a position just below the last SRP of interest. Upon release, the selected SRP’s are presented. Available space within the control limits the amount of detail information presented. If six or less SRP’s are selected using this method, all details about each is shown in the control window. If more than six is selected, grade details and reflectivity scales are omitted. This process may be repeated on results to further select profiles of interest.
The illustration below illustrates selection of two SRP's to be used for comparison.

If more than one profile is displayed, and the mouse wheel or scroll bar is moved, the display will continue to display the same number of sequential profiles. To select any one SRP, hover the mouse cursor over it and left click one time on it.

The zoom option discussed above is only available when one profile is evaluated. However, the scroll wheel or drag bar may be used to select previous or next profiles and if the zoom factor is active, it is maintained as different profiles are viewed until the normal view is reset.
• **Print Out Options**

The setup options allow inclusion of the SRP to be included on printed reports. Check the box to include the SRP. (See illustration below – item highlighted within an elliptical boundary).

If this option is selected, and the SRP tab is not visited prior to a printout, then the default SRP is selected for inclusion in the print out. If the SRP tab has been selected, then the printout will include the last SRP viewed.

The SRP may also be printed out in full scale if desired. Make sure the SRP tab has focus and the desired SRP image is present in the SRP control tab window. Click the main menu print button icon.
5.5 ANSI Parameters

The ANSI parameters section lists each of the nine ANSI parameters and gives a summary of the measurements based on all scans taken. Each parameter is completely explained below. Note that some of these parameters are average values over all of the scans, and the averages may skew or alter the apparent results. For a rigorous review of the ANSI process given on each of your codes, you should check the ANSI matrix for each code.

This section may be very helpful in situations where the barcode cannot even be read. Therefore, the descriptions of each parameter below will explain what is measured in the case where a code is read and not read. When a code is not read, the scan is analyzed for apparent quiet zones and the bars and spaces in between are used for the ANSI analysis.

1. **EDGE (Edge Determination)** – Checks that each edge between bar and space can be detected and no false bars or spaces appear due to “splitting” of bars or ink splattered into spaces. If at least one scan results in a decoded barcode, the EDGE value is the number of bars and spaces, not including quiet zones, in the code. If no scans result in a decoded barcode then the EDGE value shown is the number of bars and spaces found between quiet zones (or apparent quiet zones) on the scan on which the most bars and spaces were found. The Scan Reflectance Profile graph can also be very helpful in analyzing a code that cannot be decoded.

2. **Rl / Rd (Minimum Reflectance)** – Checks that the darkness of the bars is sufficient. Strictly speaking, the amount of light reflected by the bars (bar reflectance) must be less than half the light reflected by the spaces (space reflectance). The values shown are the light reflectance and the dark element reflectance separated by a slash. The light reflectance is the maximum reflectivity found in the scan (lightest or best space), and the dark reflectivity is the minimum reflectivity found in the scan (darkest or best bar). The requirement is for the minimum reflectivity to be no more than half the maximum reflectivity. If this requirement is met, the grade will be A, otherwise it will be F.

3. **SC (Symbol Contrast)** – Measures the contrast between the brightest space and darkest bar. The result is assigned a letter grade of A, B, C, D or F, with A being the highest contrast. The contrast is the difference between the maximum reflectivity (lightest or best space) and the minimum reflectivity (darkest or best bar). Note that Symbol Contrast is the difference between light and dark, and Rl/Rd above checks the ratio of these values.

<table>
<thead>
<tr>
<th>SC %</th>
<th>Grade</th>
</tr>
</thead>
<tbody>
<tr>
<td>&gt; 70</td>
<td>A</td>
</tr>
<tr>
<td>&gt;= 55</td>
<td>B</td>
</tr>
<tr>
<td>&gt;= 40</td>
<td>C</td>
</tr>
<tr>
<td>&gt;= 25</td>
<td>D</td>
</tr>
<tr>
<td>&lt; 25</td>
<td>F</td>
</tr>
</tbody>
</table>
4. **MinEC (Minimum Edge Contrast)** – Checks that the contrast between adjacent bars and spaces is high enough. When a barcode is scanned, a reading device must locate the edges between each bar and space. If the difference in the light and dark elements is not significant, this may not be achieved. Note that MinEC finds the worst-case contrast difference between each bar to space transition, whereas Symbol Contrast finds the best-case difference at any point across the barcode.

5. **MOD (Modulation)** – Modulation checks the edge contrast as a fraction of the overall or best case contrast measured in Symbol Contrast. Modulation is an important measure of minimum edge contrast since most barcode reading devices employ “adaptive threshold circuits” of some type that are sensitive to a symbols contrast in order to detect transitions between bars and spaces. If all bars and spaces were the same brightness, the minimum edge contrast would be equivalent to symbol contrast. In this case Modulation would be 100 percent. If some spaces are less bright than the brightest one, modulation will be some fraction of the overall contrast. Modulation therefore measures the amount of available contrast that is manifested in the worst-case bar to space transition. The percentage is assigned a letter grade. Excessive ink spread or bar growth can result in low modulation because very narrow spaces appear to be filled in by the encroaching bars in the scan reflectance profile.

6. **DEF (Defects)** – The worst-case change in reflectance within a single bar or space is a defect. The largest difference in reflectivity found in a single bar or space is measured as a percentage of the Symbol Contrast and assigned a letter grade. Defects normally measure breakups or voids within bars, or ink spots in spaces, or even the grain of a substrate in spaces. This very serious issue for scanners was not directly addressed by traditional verification techniques.

7. **DCD (Decode)** – The widths of each bar and space is measured and used to interpret the data content of the barcode according to a specific mathematical formula appropriate for the barcode type. If the barcode cannot be decoded according to the formula, the accuracy of the bar and space widths are inadequate. The printout shows the number of scans decoded over the number of scans taken, e.g. 8/10 means 8 out of 10 scans decoded.

8. **DEC (Decodability)** – Determines how accurate the bar and space widths are and how easily the widths can be determined. A perfectly accurate barcode will have 100 percent decodability, but decodability as low as 25 percent is often acceptable. Decodability is always measured in terms of the formula used to interpret the bar and space widths into the data content of the barcode. In order to read barcodes, thresholds between element widths are normally established according to prescribed “decode algorithms”. Decodability is normally the percentage of the overall tolerance range for a bar or space width that is not used up by inaccuracies.

9. **QZ (Quiet Zone)** – This check’s for adequate space on the left and right of the barcode. Each symbology specifies a minimum quiet zone. For example, UPC-A barcodes should have at least a nine module quiet zone on each side, whereas an EAN-13 barcode permits legal quiet zones to be as small as seven modules.
Using the Microsoft Excel™ Spreadsheet

6.1 Introduction

Included with the TruCheck USB user software is a feature where verification results can be captured into a Microsoft Excel™ Spreadsheet.
6.2 Starting Excel™

The Excel option can be initiated by clicking on the Icon displayed on the interface or by selecting it from the “Options” menu -> “Save results to Excel”. This can also be set to occur automatically by selecting “Auto-Prompt for Excel” in the settings menu (3.4). The spread sheet will open and can then be minimized to run in the background. All subsequent verifications will be posted to the sheet. The sheet has two user defined fields and a number of fields for grade and data which are based on the symbology and standards selected in the settings menu.

![Excel window showing results populated](image)

*Fig 6.1 – Excel window showing results populated*
6.3 Saving Calibration

Verifier Calibration results can be saved to the sheet. This is done by first verifying the Calibration Card and then selecting the “Check Camera Calibration” button within the spread sheet (see fig E1). Results will be posted to the second page of the sheet shown in figure E2 below.

![Fig E.2](image-url)
Calibrating the Unit

7.1 Introduction

Your TruCheck USB verifier is a precision optical electronic instrument. Periodic calibration is necessary to account for changes in the environment. Ambient light and temperature are typical environmental conditions that frequently change. Electrical components also drift (change characteristics) over time and this can affect the accuracy of measurements made by the TruCheck USB verifier.

The required calibration schedule depends upon the user environment. Calibration is required any time that the test for calibration does not pass. If ambient lighting conditions change (either by installing new lighting, or moving the system to a new location) calibration should be performed. In the absence of any such changes, Webscan recommends that you calibrate on a monthly basis, this is set as the default calibration reminder period. The test for calibration as specified below is required after the calibration to be sure that the calibration completed successfully.

7.2 Test for Calibration

Center the Imager over the right hand side of the UPC-A Master Grade Symbol, and initiate verification. The system will attempt to decode a 2D matrix symbol (but it will not be able to). At the end of the attempt, the display will read No Decode, and it will give R\text{max} and R\text{min} values which are used in the following test.

To verify that values are in range, check the R\text{max} / R\text{min} values using the UPC-A Master Grade on the Calibrated Conformance Standard sheet. The R\text{max} and R\text{min} values are reported on the same line of the report, in accordance with the ‘Minimum Reflectance’ ANSI parameter which requires R\text{min} to be less than half R\text{max}. However, the two values are to be treated as separate values for the purpose of checking calibration. If R\text{max} matches the target value with ± 4 and R\text{min} matches the target value with ± 2, then no calibration is necessary. Note that the units of the tolerance (±4 for R\text{max} and ±2 for R\text{min}) are actual values, not percentage of the reading. Example: For a Test Symbol with R\text{max} = 86%, a reading for R\text{max} in the range 82% through 90% is within these tolerances. Likewise, for a test symbol with R\text{min} = 6%, a reading of 4% through 8% is within these tolerances.

\textbf{Note: The tolerances for test for calibration given above are for use on the calibration target symbol only. These tolerances do not supersede the measurement tolerances on other samples which are given in Appendix E.}
7.3 How to Calibrate Your Unit

1. Locate your copy of the “Calibrated Conformance Standard” sheet that was included with your calibration target. The calibration target that is required is the “EAN/UPC Calibrated Conformance Standard” (GS1 part number CCSV-1) and is available from Webscan or GS1.

2. Click “Go Live” and position the “UPC-A Master Symbol” under the guide plate as shown in the image below.

3. Select “Options → Calibrate Remote” from the main menu.

4. Enter the $R_{\text{max}}$ and $R_{\text{min}}$ values in the respective textboxes. These values can be found by using the chart on page 1 of your “Calibration Conformance Standard-ANSI Print Quality Analysis” sheet.

5. Click on ‘Calibrate.’ The system is now being calibrated. This may take a few seconds.

   **NOTE:** The report included with the calibration barcode gives all the values in tenths. i.e. 69 would be considered a 6.9. The TruCheck expects whole numbers so you would enter 7. 824 would be considered 82.4 so you would enter 82. Once the $R_{\text{min}}$ and $R_{\text{max}}$ values are entered during the initial calibration, they will be stored in the system for future use.

6. At the end of the calibration process, the TruCheck USB calibration screen will show, “Successfully set $R_{\text{max}}$ and $R_{\text{min}}$.”

7. Check that the calibration settings are within range by verifying the “UPC-A Master Grade” symbol according to the test for calibration above.
Advanced Options

8.1 Introduction

The Advanced Settings option is to be used only in consultation with a technical support expert from Webscan. This menu option is password protected and the password will only be disclosed to the customer in case the technical support expert feels that there is a need to manually override either the ‘Pixel Dimension’ or the ‘Mil Factor’ settings.

8.2 Setting the Pixel Dimensions (if necessary)

1. Select ‘Options’ then ‘Advanced Settings’.
2. Enter the pixel dimensions as instructed by the Technical Support expert. Click on the “Set Pixel Dimensions” button and the TruCheck USB imager will verify the symbol. Do not click on the verify button to start the verification.
8.3 Setting the Mil Factor (if necessary)

1. Select ‘Options’ then ‘Advanced Settings’.
2. Enter the mil factor as instructed by the Technical Support expert from Webscan. Click on the “Set Mil Factor” button.
Software Upgrades

Software Upgrades are available via e-mail or on-line at www.webscaninc.com. You can also contact Webscan Customer Service to request the upgrade by e-mail.

The simplest option is to go to the Help Menu and select “Update”, if the computer your verifier is installed on has internet access the system will automatically Download Updates. Updates are not automatically installed and will be placed on your computer desktop for installation at your leisure.
Routine Care and Maintenance

Besides periodic calibration, the TruCheck system requires a minimum amount of care and maintenance. Since the window is located on a bottom facing surface, it is unlikely to become dirty. However, in a very dusty environment, it is necessary to clean the window surface from time to time.

It is recommended that you use a soft cloth, similar to the type used on eye glasses or camera lenses. Warm water may be used along with a gentle cloth. Slowly wipe up and down making sure to clean the entire width of the window.

WARNING!!!

NEVER USE A DETERGENT WITH ANY ABRASIVE CONTENT!

BE CAREFUL TO NOT SCRATCH THE WINDOW!
If you are having trouble with your TruCheck system, please check a few basic things.

1. Turn the system off, then on. See if this corrects the problem.

2. Make sure the system is not in Negative Mode, unless you are in fact trying to verify a Negative.

3. Calibrate the unit. After calibration, verify the calibration bar code. See if the values given by the system match the values for the Calibration card.

4. Make sure the Red Cross on your monitor is located within the Data Matrix symbol.

5. If you are not getting the LED’s to illuminate be sure the power brick is connected well to the power cable.

If these actions do not correct the problem please call Webscan Technical support as described below.
If You Need Service

If you need service for your TruCheck system, please call Webscan Technical Support at (303) 485-6811. Please be near the TruCheck system when you call and have your calibration card available. You may be instructed by Webscan to calibrate the system or to go into the Advanced Menu in an effort to find and/or fix the problem. If factory service is required for the system, you will be given RMA # (Return Material Authorization Number) that Webscan will use to track and record service activity.

The address to send equipment to is:

Webscan Inc.
Attn: RMA#_______ (put in your RMA#)
1254 Sherman Drive
Unit #1
Longmont, CO 80501
Tel (303) 485-6811
Fax (303) 485-6353

FCC Class “A” Statement:

This device complies with Part 15 of the FCC rules. Operation is subject to the following two conditions: (1) this device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

Accessories:

Call Webscan Inc. if you need a new Calibration Symbol (Order number 1556).
Uninstalling the Software

TruCheck USB Setup Wizard takes you through removing the software with instructions on every screen.

To uninstall TruCheck USB:

1. Insert the TruCheck USB CD-ROM into the CD-ROM drive. The installation program should start automatically. If it does not start, locate your CD-ROM drive in Windows Explorer and double-click the Autorun.exe program at the top-level of the CD-ROM.

2. Check ‘Remove TruCheckUSB’ and click the ‘Finish’ button in the dialogue box. The Setup Wizard will then uninstall TruCheck USB.
Removing TruCheckUSB

TruCheckUSB is being removed.

Please wait...

Installation Complete

TruCheckUSB has been successfully removed.

Click "Close" to exit.
Appendix A: Compliance Statement

Compliance Statement

Webscan certifies that the TruCheck data matrix verifier conforms to the UID quality requirements in MIL-STD 130L, MIL-STD 130L Chg. 1 and MIL-STD 130M, MIL-STD 130M Chg 1, and MIL-STD 130N.

Webscan certifies that the TruCheck USB Verifier system complies with the following specifications:
- ISO 15415
- ISO 15416
- ISO 15426-1 and 15426-2
- ANSI X3.182-1990 Bar Code Print Quality – Guideline

Webscan certifies that the TruCheck USB measures non-intrusive and intrusive direct part marks (dot peen, laser etch and chem. Etch) per AS 9132 Draft#4 dated March 2004, by vision system means. Webscan offers a variety of hardware/illumination configurations to meet the needs of various direct part mark applications. The proper hardware configuration is necessary to support AS9132 measurements.

Evidence of compliance with the aforementioned standards and traceability to National Institute of Standards and Technology (NIST) is provided through the use of Applied Image Certified Calibrated Conformance Standards which are manufactured to exacting specifications by Applied Image, Inc. for GS1 (formerly The Uniform Code Council.) Webscan tests each unit for conformity within specified tolerances per ISO 15426 parts 1 and 2.

Applied Image certified U.P.C. Calibration Standards are manufactured to Applied Image, Inc. and Uniform Code Council, Inc. specifications, using ANSI X3.182-1990 methodology, and are calibrated using standards traceable to the National Institute of Standards and Technology.
Appendix B: Computer and System requirements for the TruCheck USB

Minimum Hardware Requirements:

- Pentium III 700 MHz minimum.
- 512meg Ram minimum.
- 1.2 Gig Hard drive minimum with at least 100meg free.
- Screen resolution 1024x768 recommended, 800x600 minimum.
- USB 2 (system will not work with version 1 USB)

System Requirements:

- Important: Make sure you have the latest service pack and critical updates for the version of Windows that you are running. To find recent security updates, visit Windows Update.
- You must also be running Microsoft Internet Explorer 5.01 or later for all installations of the .NET Framework. Install Internet Explorer 6.0 Service Pack 1.
Appendix C: Engineering Specifications

- **Accuracy to Industry Standards:**
  Accuracy of the optical parameter measurements are to ISO15426 (Bar Code Verifier Conformance Specifications), as follows:

  The arithmetic mean of the measurements on 10 scans on a Primary Reference Test Symbol shall be within, Decodability: ±8%, Rmin: ±3%, Rmax: ±5%, Defect: ±8%, Modulation: ±12% (not specified in ISO15426, but our specified tolerance)

  Note: Refer to Section 2 of ISO15426.

  Note that the units of the tolerance are percentage of 100%, in other words reported units, not percentage of the reading. Example: For a Test Symbol with decodability of 88%, a reading in the range 80% through 96% is within these tolerances. Note that in most cases, measurements are more accurate than those stated above.

- **Resolution and Range:**
  a. Final Quality Grade: Scale of 0.0 to 4.0, to a resolution of 0.1. Reported also as letter grade as follows:


<table>
<thead>
<tr>
<th>Final Grade Value</th>
<th>Letter Grade</th>
</tr>
</thead>
<tbody>
<tr>
<td>≥3.5</td>
<td></td>
</tr>
<tr>
<td>≥2.5 and &lt; 3.5</td>
<td></td>
</tr>
<tr>
<td>≥1.5 and &lt; 2.5</td>
<td></td>
</tr>
<tr>
<td>≥0.5 and &lt; 1.5</td>
<td></td>
</tr>
<tr>
<td>&lt; 0.5</td>
<td></td>
</tr>
</tbody>
</table>

  b. Individual Parameters: Reported on a scale of 0 to 100 with resolution of 1. Note that the resolution of measurement is not an indication of accuracy.

- **Calibration to Industry Standards**
  Refer to section 6.2 of ISO15426.

  All TruCheck models have a means of calibrating reflectance values against reference reflectance calibration samples. Two calibration points are used, one near the high reflectance end of the range and the other near the low reflectance end of the range. The reflectance calibration target specified by Webscan is the UCC Calibrated Conformance Standard. This NIST traceable standard is a product of the Uniform Code Council (UCC), and is available through Webscan, Inc. or from the UCC directly (www.uc-council.org).

  The calibration procedure specified by Webscan, Inc. is documented in the User Manual.

- **Environmental**
  Temperature 0-40 C, Humidity: 5% - 95% non-condensing
Appendix D: Symbology specific information

The following is a list of current symbologies supported by the TruCheck Camera USB. Note that some linear symbols may be too long to fit within the viewable area of the USB camera system. There are models TruCheck Laser USB that can scan linear symbols up to 7.5” in length, so please contact Webscan for ordering information if long linear symbols are to be verified.

- **UPC**
  
  **UPCA:**

  ![](image1)

  **UPC Supplemental:**

  ![](image2)
UPCE:

UPC symbols are non-stacked, and linear. In order to verify a UPC symbol that has supplemental content, be checked in the settings menu. (If it is not, the supplemental content will be ignored.)

- **EAN**
  
  EAN13:
EAN symbols are non-stacked, and linear. EAN symbols closely resemble UPC symbols, so make a note of the “symbology” field after a verification to differentiate between the two.

- **Code 128**
  
  Code 128 symbols are linear, and non-stacked. They are encoded according to a specialized coding scheme, which has 3 character sets. These character sets are known as “A”, “B”, and “C” and each mode assigns different meanings to the codewords present in the symbol. The data detail tab will show in what character set the symbol was encoded, and when and if the character set was changed partway through the symbol.

  Code 128 symbols closely resemble Code 39 symbols and Code 93 symbols, so make a note of the “symbology” field after a verification to differentiate between them.
• **Code 39**
  Code 39:
  
  ![Code 39 Example](image)

  Code 39 is linear, and non-stacked. They closely resemble Code 128 symbols and Code 93 symbols, so make a note of the “symbology” field after a verification to differentiate between them.

• **TLC 39**
  TLC 39:
  
  ![TLC 39 Example](image)

  TLC 39 is a linear, non-stacked symbology.
- **I 2 of 5**
  
  I 2 of 5:

  ![I 2 of 5 example]

  Interleaved 2 of 5 is a continuous two-width barcode symbology, and it is both linear and non-stacked. ITF 14 is a GS1 form of I 2 of 5, and the TruCheck USB Laser software will evaluate symbols encoded according to selected standards, either I 2 of 5 standard, or GS1 – ITF14. In order to select which standard is applied, there is a drop down menu box in the decode options of the settings window.

- **I 2 of 5**
  
  CODABAR:

  ![CODABAR example]

  Codabar symbols are linear and non-stacked.
• **Code 93**
  Code 93:

  ![Code 93 Example]

  Code 93 symbols are linear and non-stacked. They closely resemble Code 128 symbols and Code 39 symbols, so make a note of the “symbology” field after a verification to differentiate between them.

• **Pharmacode**
  Pharmacode (small number):

  ![Pharmacode (small number) Example]

  Pharmacode (larger number):

  ![Pharmacode (larger number) Example]
Pharmacode symbols are linear and non-stacked. By default, the TruCheck verifier will not detect Pharmacode symbols, so if Pharmacode symbols are to be verified, there is an option in the “type of code” section of the settings menu that must be checked. It is recommended that you activate this setting only when needed, because stray marks and other types of symbols can sometimes have the proper spacing to qualify as a valid Pharmacode symbol. This issue can be avoided by turning off Pharmacode whenever Pharmacode symbols are not being verified.

The data in a Pharmacode symbol is reported twice, in both the data field of the main screen, as well as the data detail tab. The first is indicated by an “F:”, expressing the data as interpreted by a foreword scan. The second is indicated by an “R:”, indicating the data as interpreted by a reverse scan.

• **RSS**
  - RSS14:
    - RSS14 Limited:
    - RSS14 Stacked:
RSS is a stacked linear symbology. Even RSS symbols that have only 1 linear component should be treated as stacked symbols for the purposes of setting up a scan region. RSS symbols will not be detected by default, so “RSS \ Linear” in the “type of code” section of the settings menu must be checked in order to verify RSS codes. The “# of scans” option in the settings menu has no effect on RSS symbols; the appropriate number of scans will be decoded according to the technical specifications.

The reporting for RSS symbols is different than other symbologies when there is more than one component. Each component has its own grade. The grade of each component will affect the grade for the whole symbol, where the overall symbol grade is the lowest grade scored by any of its components.

It is important to note that there is a special flag inside the data of RSS codes that identifies the presence of a secondary component. If this flag is set improperly, the grade for the symbol is reported as “F” even if all other parameters receive high grades. This is reported as “link flag set, but composite component not found” in the primary report.
• **PDF417**

   PDF417 (standard):

   PDF417 Truncated:

   PDF417 is a stacked linear symbology. In order to verify PDF417 symbols, “PDF” must be selected in the “type of Code” section of the settings menu.

• **Micro PDF**

   uPDF (1 column):
Micro PDF (often abbreviated uPDF) is a linear stacked symbology. “uPDF” must be selected in the “type of code” section of the settings menu in order to verify micro PDF symbols. It is possible for an RSS composite symbol to contain a uPDF symbol as one of its components. To verify this type of symbol, “RSS \ linear” must be selected, and “uPDF” need not.

• **Data Matrix**
Data matrix is a 2D symbology. The Camera must be set to a 2D context, and “Data Matrix” must be selected in the “type of code” section of the Settings menu. “Dot peen” must be checked in the “decode options” section of the settings menu for dot peen symbols to be decoded.
Unlike many 1D symbologies, data matrix and other 2D symbols can be read and validated regardless of the orientation, so it is not necessary to attempt to determine which side is the “top” when positioning the symbol under the camera.

The number of modules in a data matrix symbol is variable, and can be chosen to be any of the options allowed in the specification documents. The size chosen will dictate the number of error correction codewords, and both the size and number of error correction codewords will be reported in the general characteristics tab.

In symbols with multiple quadrants, each quadrant will have its own finder pattern and clock tracks, and each will receive a grade as per the ISO standard.

- **Aztec**

  Aztec compact code:

  ![Aztec compact code](image)

  Aztec (standard):

  ![Aztec (standard)](image)

  Aztec (standard; large size):

  ![Aztec (standard; large size)](image)
Aztec Code is a 2D symbology. Like other 2D symbologies, Aztec Code employs an error detection and correction scheme, the details of which will be displayed in the general characteristics tab.

Unlike many 1D symbologies, Aztec Code and other 2D symbols can be read and validated regardless of the orientation, so it is not necessary to attempt to determine which side is the “top” when positioning the symbol under the camera.

• **QR Code**
  
  Micro QR:

![QR Code Micro Image]

QR: (standard):

![QR Code Standard Image]
QR Code is a 2D symbology. Like other 2D symbologies QR Code employs an error detection and correction scheme, the details of which will be displayed in the general characteristics tab.

Unlike many linear symbologies, QR Code and other 2D symbols can be read and validated regardless of the orientation, so it is not necessary to attempt to determine which side is the “top” when positioning the symbol under the camera.

- **MaxiCode**
  
  MaxiCode is a 2D hexagonal grid symbology. “MaxiCode” must be selected in the “type of code” section of the settings menu to decode MaxiCode symbols.

  Unlike most other bar coding symbologies, all MaxiCode symbols have a necessary specified size. Magnification or shrinkage of the symbol can cause a symbol to become unreadable, even if all elements are properly sized relative to each other. Magnification is not a graded parameter; however, magnification percentage will be reported in the general characteristics tab, along with a warning if the symbol is of a size not allowed in the specification.
Data in MaxiCode symbols are encoded across 3 different channels, each with its own independent error correction budget, and each with a different intended interpretation. These three channels are referred to as the high priority message, and the first and second low priority messages. The error detection and correction information for each channel will be listed separately in the general characteristics tab.

MaxiCode symbols can be encoded in any of 5 modes:

Mode 2—Mode 2 is often used in the shipping industry and it uses the high priority message to store structured information including a numeric postal code, a country code, and a service class. The two low priority channels interleave to form an accompanying message. The high priority channel uses “enhanced” error correction, and both low priority channels use “standard”.

Mode 3—Mode 3 is often used in the shipping industry and it uses the high priority message to store structured information including an alpha-numeric postal code, a country code, and a service class. The two low priority channels interleave to form an accompanying message. The high priority channel uses “enhanced” error correction, and both low priority channels use “standard”.

Mode 4—Mode 4 uses the full data capacity (including the high priority message channel) to encode a message. The high priority channel uses “enhanced” error correction, and both low priority channels use “standard”.

Mode 5—Mode 5 uses the full data capacity (including the high priority message) to encode a message. In mode 5, all channels use “enhanced” error correction. This means that mode 5 symbols have a greater error detection and correction capacity, but at the cost of a smaller data capacity compared to mode 4 symbols.

Mode 6—Mode 6 symbols encode data used to reprogram reading devices. The high priority channel uses “enhanced” error correction, and both low priority channels use “standard”.

# Table of Contents

PRODUCT INFORMATION ................................................................................................................... 1
   1.1 Welcome! ..................................................................................................................................................... 1
   1.2 Package Contents ......................................................................................................................................... 2

INSTALLATION INSTRUCTIONS ........................................................................................................ 3
   2.1 Software Installation Instructions ................................................................................................................. 3
   2.2 To install TruCheck USB Laser Software ........................................................................................................ 4
   2.3 Hardware Installation Instructions ................................................................................................................ 7
   2.4 Using the Verifier for the First Time .............................................................................................................. 9

USING THE TRUCHECK USB APPLICATION ................................................................................. 10
   3.1 Introduction ................................................................................................................................................ 10
   3.2 User Interface Overview .............................................................................................................................. 11
   3.3 User Interface Details .................................................................................................................................. 12
      3.3.1 The File, Options and Help Menus .................................................................................................................. 12
      3.3.2 Icons Located on the User Interface ................................................................................................................ 14
   3.4 System Setup using the Settings Menu ........................................................................................................ 15
      3.4.1 Details for the Settings Menu .......................................................................................................................... 16

VERIFYING SYMBOLS ......................................................................................................................... 19
   4.1 Introduction ................................................................................................................................................ 19
   4.2 Setting the scan region ................................................................................................................................ 20
   4.3 Verifying a linear non-stacked symbol ......................................................................................................... 24
   4.4 Verifying an “RSS Composite” stacked symbol with GS1 format checking ..................................................... 25
   4.5 Scan Reflectivity Profile (SRP) ...................................................................................................................... 28
      4.5.1 Interpreting the presented information .......................................................................................................... 28
   4.6 ANSI Parameters ......................................................................................................................................... 38

USING THE MICROSOFT EXCEL™ SPREADSHEET ...................................................................... 40

CALIBRATING THE TRUCHECK USB LASER ................................................................................ 43

ADVANCED OPTIONS .......................................................................................................................... 46

SOFTWARE UPGRADES ...................................................................................................................... 48
Product Information

1.1 Welcome!

Congratulations on the purchase of your TruCheck™ USB verifier! With this system, you can reach a new level of quality assurance.

The Webscan TruCheck USB Laser barcode verifier, based on ANSI/ISO methodology, scans and verifies the print quality of 1D and 2D barcode symbols. Detailed reports of print quality are produced for printout or electronic archival.

The TruCheck USB Laser system is as easy to use as it is powerful. The main features of the system are:

- Accurate barcode verification according to global standards
- Repeatable results
- Calibrated and traceable to NIST standards
- Intuitive User Interface
- Detailed reporting
- Storage of verification results in Adobe PDF, HTML, MS Excel and CSV
- Easy to use
- Consistent results independent of operator training or skill

This manual will guide you in using the TruCheck USB Laser verifier and in fully understanding the available features. Also, it will assist you in understanding the verification results shown on the display and printed reports.

*TruCheck is a trademark of Webscan Inc.*
1.2 Package Contents

Check the verifier package for the following items.

1. TruCheck USB Laser Remote (TruRemote)
2. TruCheck USB Laser User Interface Installation CD
3. Power Supply
4. GS1 Calibration Card (ordered separately)
5. Fast setup instructions for your unit.
6. Specification sheet detailing the system requirements necessary for use of the TruCheck USB Laser system.

If any of the above items are missing please contact Webscan. (Contact information can be found in the “if you need service” section near the end of the manual.)
2.1 Software Installation Instructions

TruCheck USB Laser installation program takes you through the installation with instructions on every screen.

Before installing TruCheck USB Laser:

Close all other applications.

- Make sure the TruCheck USB Laser hardware is **not** plugged into the computer.

  *Note: If the TruCheck USB Laser hardware is plugged in before, or during the software installation, the computer will install the TruCheck USB Laser as an “unknown” device and it will not function.*

Log into your computer with administrator privileges if you are installing on Windows XP/Vista/7.
2.2 To install TruCheck USB Laser Software

Insert the TruCheck USB Laser CD-ROM into the CD-ROM drive. The installation program should start automatically. If it does not start, locate your CD-ROM drive in Windows Explorer and double-click the Setup.exe program at the top-level of the CD-ROM.

Follow the on-screen prompts to complete the installation.

Click Next
Click Next

Click Next
Wait until the program has finished loading

Once the program has finished loading the hardware can be plugged in. Follow the Hardware Installation instructions on the next page to install the hardware drivers.
2.3 Hardware Installation Instructions

*Note: The TruCheck USB Laser software should already have been installed in accordance with the preceding section of this manual before plugging in the TruCheck USB Laser hardware to the computer.*

The following information shows the proper setup procedures for your new TruCheck USB Laser. Before proceeding, locate the remote and any accessories you purchased.

To install TruCheck USB Laser Hardware:

Please connect the USB remote laser directly to a USB port on the computer. The USB port on the computer must support USB 2.0.

Please connect the power supply to the verifier cable.

When prompted for the location of the drivers or any other files required during installation of the hardware drivers, please use the following folders: the “Drivers” folder on the CD or the path “C:\Program Files\Webscan Inc\TruCheckUSB\Drivers”

Follow the on-screen prompts to complete the hardware installation. These following steps need to be followed to install Webscan TruCheck USB Bootloader and then repeated for the Webscan TruCheck USB Laser.

Once the USB cable is attached to the computer you should see the “Found New Hardware” dialogue.
Choose Next

Path should be “C:\Program Files\Webscan Inc\TruCheckUSB\Drivers”
Click Finish to complete installation.

Upon success, you will hear the remote initialize, and the red LED on top of the unit will flash about once per second.

2.4 Using the Verifier for the First Time

Double-click the Webscan TruCheck USB icon on the Windows desktop or from “Start → All Programs → Webscan Inc → Webscan TruCheck USB”.

As the software loads, the “Laser ON” LED on the remote will stop blinking and stay solid, indicating that the laser is active.

The remote should now be calibrated (more details in Chapter 6). Select the appropriate options for your application using the “Settings” Menu (more details in section 3.4).

Your verifier should be ready to use.
Using the TruCheck USB Application

3.1 Introduction

The TruCheck USB user interface allows the user to control every aspect of the TruCheck USB Laser verifier and create and save various reports. This portion of the manual will describe in detail the operation of the user interface.

The application can be started by double clicking the “Webscan TruCheckUSB” icon on the desktop or by going to “Start → All Program → Webscan Inc → Webscan TruCheckUSB”
3.2 User Interface Overview

The startup screen of the TruCheck USB Laser user interface with a brief description of each object, details follow in the next section.
3.3 User Interface Details

3.3.1 The File, Options and Help Menus

- **File Menu**
  - **Print Report** – Allows the operator to select any printer in the Windows Printer Folder for printed reports.
  - **Print Strip Report** – Prints a report formatted to 40 columns to be printed to an attached thermal or dot matrix printer.
  - **User Password Options** – Allows the System Administrator to set Password Protection on the “Settings” and “Calibration” menus. In order to change the password, you need to enter the current password. The default password as shipped from Webscan is “user” (using lower case letters).
  - **Exit** – Used for an orderly shut down of the application.

- **Options**
  - **Settings** – Sets up the system for symbology, quality standards selection and reporting options. This menu is explained in detail in Section 3.4 of this Manual.
  - **Advanced Settings** – These settings are password protected, these settings should only be accessed when instructed by a technical support representative from Webscan.
  - **Calibrate Remote** – This is the Calibration menu, detailed Calibration instructions are in Chapter 7 of this Manual.
  - **Save Results to Excel™** - Selecting this option initiates a Microsoft Excel™ file to open and collect all subsequent verification results. The File is saved at the selected path set up in “Settings”. This process can also be initiated by clicking on the Excel Icon located on the User Interface. Detailed explanation of the setup and use of the Spreadsheet are in Chapter 6 of this Manual.

- **Help**
  - **Calibration Log** – A complete log of date and time the verifier has been calibrated.
  - **Debug Information** –
    - **Save Now** - Used to save a file of problematic codes for evaluation by Webscan. Select this option after the scan and save the file to a known location. This file can be emailed to Webscan for evaluation.
- **Save Before Verify** – Used to save a file of problematic codes for evaluation by Webscan, in cases where the verification process causes the software to crash, or otherwise prevents the saving debug information after the scan has taken place. **About** – Lists the current software revision.

  - **Update** – If the PC that the verifier is connected to has internet access this option will initiate a check of more current software and download the software to the machine for installation. Details for upgrading software are in Chapter 7 of this manual.
3.3.2 Icons Located on the User Interface

- **Diagnostic Icons**

  **The 1D Icon** – The 1D icon will open the settings menu.

  ![1D Icon](image1)

  **The 2D Icon** – This button is used to change the remote to evaluate 2D symbols. In the case of a laser remote, 2D symbols cannot be evaluated and this button will open a window suggesting the acquisition of a camera remote.

  ![2D Icon](image2)

  **Numbered hotkeys** – These can be used to set up begin and end lines, which can be useful if you frequently switch between verifying several different sized symbols. They are preset with popular scan ranges. To define your own hotkeys, adjust begin and end lines to the desired positions, (see section 4.2) and hold down the ‘CTRL’ key while pressing the numbered preset button. From then on, that button will set begin and end lines to the saved locations.

  ![Numbered hotkeys](image3)

  **The Excel Icon** – This icon initiates the Excel spread sheet for capturing data from verification. Microsoft Excel needs to be installed on the machine and the report path needs to be set in the Settings menu explained in detail in Chapter 5 of this manual.

  ![Excel Icon](image4)

  **The Print Icon** – This icon will print the results of the last barcode verified to the Default Windows Printer.

  ![Print Icon](image5)
3.4 System Setup using the Settings Menu

The following settings can be accessed through the “Options → Settings” menu selection. Select the settings needed for your application or specific verification results.

Fig 3.4.1 – The settings dialog.
3.4.1 Details for the Settings Menu

• Type of code

Select the appropriate box for the type of symbol you are verifying. For best results, deselect all boxes for code types you are not verifying.

• Decode Options

  o **I25/ITF14** – Select “Standard I25” to evaluate per ANSI/ISO I25 standard, or “GS1 ITF14” to evaluate per the GS1 criteria.

  o **Pass Grade** – Establishes what the minimum acceptable grade is for the user’s application. When activated, this displays a new field on the main screen that not only displays the grade, but turns red if the grade received is lower the minimum set, and green if the grade is higher. This is useful in providing an “at a glance” acceptance or failure.

  o **# scans** – This setting changes the number of scans over the entire symbol area that the software will use to grade the symbol. The number of scans set here are spaced evenly, with the first scan being the “start” line and the last being the “end” line. The grade report will express a composite score for all scans. The detailed report will show the grade for each individual scan line. Ten is the default value.

  o **UPC Sup** - to evaluate UPC Supplemental symbol extensions. Options include none (default), Auto, 2-digit and 5-digit. Choose Auto to let the software decide, or one of the other options.

  o **Spot size** – This is a physical property of the installed laser; it cannot be adjusted.

  o **Wavelength** – This is a physical property of the installed laser; it cannot be adjusted.

• Report Options

These are the selections which determine what quality standards and optional sections will print on the reports and display on the user interface.

  o **ISO15415/6** – The symbology is evaluated against these ISO standards.

  o **Codeword** – Turns on the reporting of the PDF codewords when verifying PDF or uPDF symbols. Values are reported on printed and saved reports as well as in the “Data Detail” tab.

  o **ASCII Values** – Turns on the reporting of the ASCII values for the encoded characters. Applies only to matrix codes (PDF417 and uPDF).
- **10 Scans Grid (value)** – This turns on the letter grade reporting for each individual scan, expressing the grade result as a value between 0 and 100 percent.

- **10 Scans Grid (letter)** – This turns on the letter grade reporting for each of the 9 ANSI parameters for each individual scan, expressing the result as a letter grade. The grade letters follow traditional scholastic systems with an ‘A’ being the highest and an ‘F’ the lowest grade.

- **Element Widths** – This setting enable reporting of the actual measured widths, and the deviation of the bars and spaces in the symbol, broken down by individual characters or codewords. This shows up on the “Advanced Detail” tab in the application.

- **SRP** – This option will print on the reports the scan reflectance profile from linear one dimensional barcodes. The SRP can always be viewed for linear barcodes in the SRP tab regardless of this selection.

- **ECC Details** – printout error correction details for PDF417 and uPDF symbols.

- **Global Options**

  - **Pre – Press negative** - If this feature is set, the system will verify negatives such as films used to develop printing plates. (Bars white and black spaces)

  - **Invert Image** – This option interprets the scan as “light on dark”, and should only be used then printing a lightly colored symbol on a dark background.

  - **Auto Print** – This option when selected will automatically print a report to the default Windows printer after all verifications. To change which printer is the default, select File → print report. In the list of installed printers, one will have a small black check mark indicating that it is the current default printer. Right click on the desired printer and select “set as default printer”.

  - **Auto print strip report** – This option will automatically print a strip report to an installed thermal or dot matrix printer. Be sure to select the correct type of printer in the drop down box below this option.

  - **Save Report** – This option triggers or turns on the automatic saving of reports to the selected formats and paths selected in the “Report Path” options. This option will have no effect if the report file options are not configured. This single selection could stop or start reporting without the need to reselect all of the Report options.

  - **Metric Units** – This option would report nominal x-dimensions and other numeric information in metric instead of imperial units. The most noticeable change this makes is distances expressed as micro meters instead of mils.

  - **Strip Printer Type** – Options include Thermal which is normally associated with a 40 column thermal printer, or Dot Matrix. These printers are selected using the options described under File → Print Strip Report.
- **GS1 Data Parsing** - Turns on the detailed parsing of the GS1 data string in the printed and saved reports. This shows up in the “Data Detail” tab.

- **Report File Options**
  - **User Name** – If a name is entered, it is printed as the “Verified By” name in the beginning of the report. If no name is entered the “Verified By” portion is not printed anywhere in the report.
  - **Excel™ File** – This is the path to a Microsoft Excel™ spreadsheet. This spreadsheet must be based on the template Excel spreadsheet provided by Webscan. By default the template is available under the “C:\Program Files\Webscan Inc\TruCheckUSB” folder. It is recommended that the user copy this file to a convenient folder. The user should then click on the browse button and select this newly copied file. Macros must be enabled in Excel for this feature to work properly. The template file name format is “Webscan Data Capture<version>.xls”.
  - **Report Path** – This is the path either on a local hard drive or on a network file server where selected reports are saved. These are automatically saved in one or any combination of the selected formats. (PDF, CSV, HTML, and/or TEXT) Again the user must have permission to write to the desired location, and the location must be selected by browsing to the location. The file saved has the following naming convention:

    <Symbology><Date Time Stamp>-<Up to 40 chars of symbol data>

    - If the symbol contains more than 40 characters, the last character printed in the filename is an ‘!’ indicating truncation.
    - Invalid filename characters are replaced by an ‘_’
  - **Append File** – This is the path where Appended PDF files are saved. The path must include a valid Adobe PDF File Name. As previously mentioned the user needs write permissions, and the location must be selected by browsing to the location.
  - **Report Format Selection** – These are for the file types that are created in the” Report Path” (PDF, CSV, HTML and TEXT). If multiple file types are selected a file for each of those types is created in the folder of the Report Path.

*Note: The reports even though selected will not be automatically saved unless the “Save Report” option is selected in the “Report Options” section. This option gives the operator the ability to disable write reports with a single selection and without having to change the report types or paths. This is beneficial in the event of testing codes to alleviate print process issues where individually saved reports may not be desired.*
Verifying Symbols

4.1 Introduction

Place the TruCheck USB Laser remote over the symbol, using the opening in the guide plate to be sure that the symbol is in the field of view. There are small notches in the guide plate opening that indicate the center of the field of view.

Fig 4.1 – Laser remote placed on top of a symbol, with the symbol to be verified visible through the opening in the guide plate.
Note that the symbol must be properly aligned in order to be verified. It is important that the symbol is centered within the sweep of the laser. This can be best accomplished by using the notches in the guide plate opening as a reference.

If you have a presentation stand model, there are white lines to indicate the center of the scan line.

Once the symbol is level, and centered in the field of view, the start and end lines must be established. This sets the range of motion of the laser through the height of the symbol, and establishes the region to be scanned.

### 4.2 Setting the scan region

If the symbol to be verified is of a stacked symbology type, (if you are not sure if your symbol qualifies as “stacked”, see appendix D) click and drag the red lines so that the line labeled “begin” is just above the top of the symbol, and the line labeled “end” is just below the bottom. The sweep of the laser should start and end outside of the code.

If the symbol to be verified is of a non-stacked symbology type, click and drag the red lines so that the line labeled “begin” is just below the top of the symbol and the line labeled “end” is just above the bottom. The gap between these two lines establishes the area to be evaluated by the verifier. It is important that these top and bottom lines fit cleanly inside the symbol. If they do not, the verifier will report a “no decode” for any of the lines that were not completely inside the symbol. This can cause a poor grade to be reported on a well printed symbol. See below for an example of properly defined begin and end lines for stacked and non-stacked symbols.
Sweep setup buttons:

Selects the begin line. When pressed, the laser will move to the current begin position, and all adjustments made will apply to the begin position. Note that at all times, when begin is selected, the end button will appear dim.
Selects the end line. When pressed, the laser will move to the current end position, and all adjustments made will apply to the end position. Note that at all times, when end is selected, the begin button will appear dim.

The home button will return the laser to the highest extreme of its movement. This will not affect the location of the begin line, nor the location of the end line.

Adjust the currently selected line upward. Press and hold this button to make needed adjustments, avoid rapid tapping of this button. Sudden engaging and disengaging of the motor can cause it to stall.

Adjust the currently selected line downward. Press and hold this button to make needed adjustments, avoid rapid tapping of this button. Sudden engaging and disengaging of the motor can cause it to stall.

Alternatively, the mouse can be used to adjust the start and end lines. Click and drag the red “Begin” or “End” lines on the screen, keeping in mind that the remote’s laser will follow the changes you make when you release the mouse button, so observe the location of the laser to determine what adjustments are needed.

If the desired locations are known, and the motion of the laser is not needed to determine the size of adjustments, holding the “CTRL” key while clicking and dragging the begin or end lines will adjust the begin and end lines without any motion from laser.

Once the “Begin” and “End” lines have been set, the remote is now ready to verify your symbol.
The “Acceptance Criteria” reports a pass or fail based on the “Pass Grade” criteria set under the system settings.
4.3 Verifying a linear non-stacked symbol

In the settings menu, verify that all current settings are relevant to a linear, non-stacked barcode.

Place the TruCheck USB Laser over the barcode, with the symbol centered, and visible through the cutout in the guide plate.

Establish the start and end lines, as directed in section 4.2.

Note: the symbol used in this example is not of a stacked variety, and as such, the “Begin” and “End” lines should be within the symbol.

![Image of application window showing verification results after the barcode is analyzed]

The above image shows the application window after the symbol has been verified.

The acceptance criteria box shows whether the symbol passed or failed the verification based on the “Pass Grade” set in the system settings dialog.

The SRP (Scan Reflectance Profile) tab shows the reflectance profile for each of the scans, details regarding the data displayed in this tab can be found in the SRP section in section 4.5.
4.4 Verifying an “RSS Composite” stacked symbol with GS1 format checking

To verify any variety of RSS symbols, “RSS \ Linear” must be selected in the “type of code” region of the settings menu.

To enable GS1 data format checking select “Auto” or “Always” in the “Options → Settings” menu under the “Decode Options”. Since, the RSS symbology is a GS1 symbology, both the “Auto” and the “Always” options will check for a valid data format within the symbol verified.

![Application window with a RSS composite symbol after verification with GS1 format checking](image)

**Fig 4.4.1 – Application window with a RSS composite symbol after verification with GS1 format checking**

When a RSS symbol is verified with GS1 format checking turned on, the data is parsed and each data component is passed or failed based on those rules. In order to obtain a passing grade for the “GS1 Acceptance Criteria”, both the data and symbol quality must meet the criteria set by GS1.
The “Data Detail” tab shows further details of the parsed data and any failures are reported on this tab. This comes in handy when troubleshooting issues with “GS1 Acceptance Criteria” failures.

The parsed data is tabulated to show the data in the field, what the data denotes and whether the field passes or fails according to the rules set forth by GS1 for the specific AI’s and their data content.
The “Quality Detail” tab for linear one and two dimensional symbols shows nine ANSI parameters for each of the scans used to calculate the verification grade for the symbol.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Grade</th>
</tr>
</thead>
<tbody>
<tr>
<td>M</td>
<td>A</td>
</tr>
<tr>
<td>N</td>
<td>A</td>
</tr>
<tr>
<td>T</td>
<td>A</td>
</tr>
<tr>
<td>G</td>
<td>A</td>
</tr>
<tr>
<td>R</td>
<td>A</td>
</tr>
<tr>
<td>C</td>
<td>A</td>
</tr>
<tr>
<td>D</td>
<td>A</td>
</tr>
<tr>
<td>E</td>
<td>A</td>
</tr>
</tbody>
</table>

Fig 4.4.3 – Application window showing the “Quality Detail” tab
4.5 Scan Reflectivity Profile (SRP)

The SRP page can be viewed by clicking on the tab labeled “SRP”. In this mode, the default profile presented is the scan with the best grade closest to the center of the scanned lines for a symbol row. On a stacked symbology, where more than ten scan lines are presented, a profile meeting the conditions described above and from the primary row is presented. If an SRP has been previously selected, and another tab is viewed, the same SRP is presented on return.

After entering the SRP page, use the mouse wheel or the vertical scroll bar to view any available scan profile. To return to the “Main” tab, double left click anywhere within the SRP tab control window. Other tabs may be selected for viewing at any time as desired.

4.5.1 Interpreting the presented information

Under normal circumstances, when only one SRP view is presented, the control window presents a variety of information.
Fig 4.5.1.1 – SRP of a typical scan.
The first image represents the scan as captured by the laser, directly beneath it is the black and white representation of this data. This representation is shown only if the current scan was successfully decoded.

The following is a list of the information presented on the SRP graphic:

- **Index**
  
The value listed is always between 1 and 10 for any given row/component of the symbol (e.g.: for a RSS stacked symbol with two rows, the index numbers would be labeled from 1 to 10 for the first row and 11 to 20 for the second row, etc). These values correspond to those indexed and listed under the “Quality Detail” tab.

- **Scan**
  
The first numeric value is a scan index and increments for each scan captured by the TruCheck USB Laser. It differs from the ‘Index’ described above in that it is the absolute scan number. The next numeric value listed represents the actual scan line from the imager. In a stacked symbology, the sequencing based solely on the index values described above is not always apparent. This value can be used to correlate relative position of the yellow lines shown on the image under the “Main” tab. The value listed here is always sequential top to bottom.

- **Grade**
  
The overall grade for a given profile. This grade corresponds to the grade listed under the tab “Quality Detail”. In a case where the scan did not decode, this parameter will reflect “n/a”.

- **Reflectivity Scale**
  
A green dashed line beneath the B&W view represents 100% reflectivity. A second green dashed line at the bottom of the image space represents 0% reflectivity. These lines are based on the black and white reflectivity measurements taken from the calibration card and its corresponding calibrated values.

- **Global Threshold**
  
The white line between the green reflectivity scale lines represents a global threshold. This line represents the average reflectivity of the symbol under test. In general it is a good approximation of the threshold used to determine where the digital transition takes place as the SRP crosses it. This is reflected in the B&W representation discussed above. The global threshold value is indicated in green in the left margin.
**SRP**

The analog signal normally represented in “Blue” is just another way of viewing the laser scan displayed at the top of the control. It is a representation of the sequential pixel values captured by the laser remote. The SRP may also include segments that are colored differently. The colors indicate an element within the SRP that resulted in a grade contribution that was less than an ‘A’. The color codes are as follows, A – blue, B – green, C – yellow, D – orange and F – red.

A tooltip will popup if the mouse is hovered over a colored element. The tooltip will indicate a reason code, its grade, and measured value. In the example above, the tooltip indicates element #29 has a defect that measured 20, and received a ‘B’ grade. The reason codes listed under the “Quality Detail” tab for each profile will reflect the worst grade for a parameter in the scan. In some cases the tooltip balloon box may list more than one reason code. In addition the same reason code may be displayed by multiple elements, the worst being the one listed under the “Quality Detail” tab.
• **Advanced Option Horizontal Zoom**

In some cases, more detail may be desired. To zoom in on a problem element(s), position the mouse cursor at a start location, click the left button and while holding it, drag to an end position. As the mouse is dragged, a brown dashed line will appear indicating the area being zoomed. Upon release of the left mouse button, the control is redrawn showing only the area previously selected. To further improve resolution, maximize the application window. To return to a normal view left click one time anywhere within the control window.
**Advanced Option Multiple SRP select**

In some cases the user may want to compare one or more SRP’s of sequential profiles, for instance in a case where a defect is running through multiple scan lines. In this scenario the sequential SRP’s will all show the same element highlighted.

To select a group, first right click one time in the SRP control window. This will result in a view showing all available SRP’s.

![SRP Control Window](image)

In this window, position the mouse cursor just above the first SRP of interest, click and hold the left mouse button and drag to a position just below the last SRP of interest. Upon release, the selected SRP’s are presented. Available space within the control limits the amount of detail information presented. If six or less SRP’s are selected using this method, all details about each is shown in the control window. If more than six is selected, grade details and reflectivity scales are omitted. This process may be repeated on results to further select profiles of interest.

The illustration below illustrates selection of two SRP’s to be used for comparison.
If more than one profile is displayed, and the mouse wheel or scroll bar is moved, the display will continue to display the same number of sequential profiles. To select any one SRP, hover the mouse cursor over it and left click one time on it.

The zoom option discussed above is only available when one profile is evaluated. However, the scroll wheel or drag bar may be used to select previous or next profiles and if the zoom factor is active, it is maintained as different profiles are viewed until the normal view is reset.
• **Print Out Options**

The setup options allow inclusion of the SRP to be included on printed reports. Check the box to include the SRP. (See illustration below – item highlighted within an elliptical boundary).
If this option is selected, and the SRP tab is not visited prior to a printout, then the default SRP is selected for inclusion in the print out. If the SRP tab has been selected, then the printout will include the last SRP viewed.

The SRP may also be printed out in full scale if desired. Make sure the SRP tab has focus and the desired SRP image is present in the SRP control tab window. Click the main menu print button icon.

*Note – Checking SRP only applies to printed reports, not saved reports.*
4.6 ANSI Parameters

The ANSI parameters section lists each of the nine ANSI parameters and gives a summary of the measurements based on all scans taken. Each parameter is completely explained below. Note that some of these parameters are average values over all of the scans, and the averages may skew or alter the apparent results. For a rigorous review of the ANSI process given on each of your codes, you should check the ANSI matrix for each code.

This section may be very helpful in situations where the barcode cannot even be read. Therefore, the descriptions of each parameter below will explain what is measured in the case where a code is read and not read. When a code is not read, the scan is analyzed for apparent quiet zones and the bars and spaces in between are used for the ANSI analysis.

1. **EDGE (Edge Determination)** – Checks that each edge between bar and space can be detected and no false bars or spaces appear due to “splitting” of bars or ink splattered into spaces. If at least one scan results in a decoded barcode, the EDGE value is the number of bars and spaces, not including quiet zones, in the code. If no scans result in a decoded barcode then the EDGE value shown is the number of bars and spaces found between quiet zones (or apparent quiet zones) on the scan on which the most bars and spaces were found. The Scan Reflectance Profile graph can also be very helpful in analyzing a code that cannot be decoded.

2. **RI / Rd (Minimum Reflectance)** – Checks that the darkness of the bars is sufficient. Strictly speaking, the amount of light reflected by the bars (bar reflectance) must be less than half the light reflected by the spaces (space reflectance). The values shown are the light reflectance and the dark element reflectance separated by a slash. The light reflectance is the maximum reflectivity found in the scan (lightest or best space), and the dark reflectivity is the minimum reflectivity found in the scan (darkest or best bar). The requirement is for the minimum reflectivity to be no more than half the maximum reflectivity. If this requirement is met, the grade is A, otherwise it is F.

3. **SC (Symbol Contrast)** – Measures the contrast between the brightest space and darkest bar. The result is assigned a letter grade of A, B, C, D or F, with A being the highest contrast. The contrast is the difference between the maximum reflectivity (lightest or best space) and the minimum reflectivity (darkest or best bar). Note that Symbol Contrast is the difference between light and dark, and RI/Rd above checks the ratio of these values.

<table>
<thead>
<tr>
<th>SC %</th>
<th>Grade</th>
</tr>
</thead>
<tbody>
<tr>
<td>&gt; 70</td>
<td>A</td>
</tr>
<tr>
<td>&gt;= 55</td>
<td>B</td>
</tr>
<tr>
<td>&gt;= 40</td>
<td>C</td>
</tr>
<tr>
<td>&gt;= 25</td>
<td>D</td>
</tr>
<tr>
<td>&lt; 25</td>
<td>F</td>
</tr>
</tbody>
</table>
4. **MinEC (Minimum Edge Contrast)** – Checks that the contrast between adjacent bars and spaces is high enough. When a barcode is scanned, a reading device must locate the edges between each bar and space. If the difference in the light and dark elements is not significant, this may not be achieved. Note that MinEC finds the worst-case contrast difference between each bar to space transition, whereas Symbol Contrast finds the best-case difference at any point across the barcode.

5. **MOD (Modulation)** – Modulation checks the edge contrast as a fraction of the overall or best case contrast measured in Symbol Contrast. Modulation is an important measure of minimum edge contrast since most barcode reading devices employ “adaptive threshold circuits” of some type that are sensitive to a symbol’s contrast in order to detect transitions between bars and spaces. If all bars and spaces were the same brightness, the minimum edge contrast would be equivalent to symbol contrast. In this case Modulation would be 100 percent. If some spaces are less bright than the brightest one, modulation is some fraction of the overall contrast. Modulation therefore measures the amount of available contrast that is manifested in the worst-case bar to space transition. The percentage is assigned a letter grade. Excessive ink spread or bar growth can result in low modulation because very narrow spaces appear to be filled in by the encroaching bars in the scan reflectance profile.

6. **DEF (Defects)** – The worst-case change in reflectance within a single bar or space is a defect. The largest difference in reflectivity found in a single bar or space is measured as a percentage of the Symbol Contrast and assigned a letter grade. Defects normally measure breakups or voids within bars, or ink spots in spaces, or even the grain of a substrate in spaces. This very serious issue for scanners was not directly addressed by traditional verification techniques.

7. **DCD (Decode)** – The widths of each bar and space is measured and used to interpret the data content of the barcode according to a specific mathematical formula appropriate for the barcode type. If the barcode cannot be decoded according to the formula, the accuracy of the bar and space widths are inadequate. The printout shows the number of scans decoded over the number of scans taken, e.g. 8/10 means 8 out of 10 scans decoded.

8. **DEC (Decodability)** – Determines how accurate the bar and space widths are and how easily the widths can be determined. A perfectly accurate barcode will have 100 percent decodability, but decodability as low as 25 percent is often acceptable. Decodability is always measured in terms of the formula used to interpret the bar and space widths into the data content of the barcode. In order to read barcodes, thresholds between element widths are normally established according to prescribed “decode algorithms”. Decodability is normally the percentage of the overall tolerance range for a bar or space width that is not used up by inaccuracies.

9. **QZ (Quiet Zone)** – This check’s for adequate space on the left and right of the barcode. Each symbology specifies a minimum quiet zone. For example, UPC-A barcodes should have at least a nine.
Using the Microsoft Excel™
Spreadsheet

Included with the TruCheck USB Laser software is a feature where verification results can be captured into a Microsoft Excel™ Spread Sheet. In order to utilize this option there needs to be a path to the sheet template, set in the Settings Menu. Instructions are found in section 3.4.1 of this manual.

The Excel option can be initiated by clicking on the Icon displayed on the interface or by selecting it from the “Options” menu -> “Save results to Excel”. The spread sheet will open and can then be minimized to run in the background. All subsequent verifications are posted to the sheet. The sheet should be copied to a different folder than the original so that the original template remains a blank sheet. The sheet has two user defined fields and a number of fields for grade and data which are based on the symbology and standards selected in the “Settings” menu.
Verifier Calibration results can be saved to the sheet. This is done by first verifying the Calibration Card and then selecting the “Check Calibration” button within the spreadsheet (see fig E1). Results are posted to the second page of the sheet shown in figure E2 below.
Fig E.2 The calibration check sheet.

<table>
<thead>
<tr>
<th></th>
<th>Rmax</th>
<th>Target</th>
<th>Rmax Deviation</th>
<th>Rmin</th>
<th>Target</th>
<th>Rmin Deviation</th>
<th>Date</th>
<th>Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>01-Nov-2008</td>
<td>12:39:06</td>
</tr>
</tbody>
</table>
Calibrating the TruCheck USB Laser

Your TruCheck Laser USB verifier is a precision optical electronic instrument. Periodic calibration is necessary to account for changes in the environment. Ambient light and temperature are typical environmental conditions that frequently change. Electrical components also drift (change characteristics) over time and this can affect the accuracy of measurements made by the TruCheck USB Laser verifier.

The required calibration schedule depends upon the user environment. Calibration is required any time that the test for calibration does not pass. If ambient lighting conditions change (either by installing new lighting, or moving the system to a new location) calibration should be performed. In the absence of any such changes, Webscan recommends that you calibrate on a monthly basis, this is set as the default calibration reminder period. The test for calibration as specified below is required after the calibration to be sure that the calibration completed successfully.

- **Test for Calibration**

  Center the Imager over the UPC-A Master Grade Symbol, and initiate verification. The system will attempt to decode the symbol. At the end of the attempt it will give Rl and Rd values which are used in the following test.

  To verify that values are in range, check the Rl / Rd values using the UPC-A Master Grade on the *Calibrated Conformance Standard* sheet. The Rl and Rd values are reported on the same line of the report, in accordance with the ‘Minimum Reflectance’ ANSI parameter which requires Rd to be less than half Rl. However, the two values are to be treated as separate values for the purpose of checking calibration. If Rl matches the target value within ± 4 and Rd matches the target value with ± 2, then no calibration is necessary. Note that the units of the tolerance (±4 for Rl and ±2 for Rd) are actual values, not percentage of the reading. Example: For a Test Symbol with Rmax = 86%, a Rl reading for Rmax in the range 82% through 90% is within these tolerances. Likewise, for a test symbol with Rmin = 6%, a Rd reading of 4% through 8% is within these tolerances.

  *Note: The tolerances for test for calibration given above are for use on the calibration target symbol only. These tolerances do not supersede the measurement tolerances on other samples which are given in Appendix E.*
• How to Calibrate Your Unit

1. Locate your copy of the “Calibrated Conformance Standard” sheet that was included with your calibration target. The calibration target that is required is the “EAN/UPC Calibrated Conformance Standard” (GS1 part number CCSV-1) and is available from Webscan or GS1. Note that there are multiple versions, each designed for use with different apertures. Below the title, there will be a line that reads “using 3 Mil apertures”, “using 6 Mil apertures” or “using 10 Mil apertures”. Make sure that the correct calibration target is used.

2. Set up the begin and end lines as normal over the symbol, taking special care to be sure that the symbol is centered in the opening in the guide plate. Hotkey 1 is setup by default for the calibration symbol.

3. Select “Options → Calibrate Remote” from the main menu.

4. Enter the $R_{\text{max}}$ and $R_{\text{min}}$ values in the respective textboxes. These values can be found by using the chart on page 1 of your “Calibration Conformance Standard-ANSI Print Quality Analysis” sheet.

**NOTE:** Enter values exactly as they appear on the report included with the calibration card. The interface can also accept values expressed as percentages, so long as the same format is used for both $R_{\text{min}}$ and $R_{\text{max}}$. If percentages are used, make sure to round appropriately, to the nearest whole percentage. The unit will not accept values of 0, or values entered in the incorrect boxes, so be careful to enter the information correctly.
5. Click on ‘Calibrate.’ The system is now being calibrated. This may take a few seconds.

6. At the end of the calibration process, the TruCheck Laser USB calibration screen will show, “Successfully set Rmax and Rmin”.

7. Check that the calibration settings are within range by verifying the “UPC-A Master Grade” symbol according to the test for calibration above. The quality detail tab should show values expressed as Rl/Rd and should be very near the values for Rmax and Rmin entered in calibration. Note that the overall grade for this symbol is likely to be a C since the failing portion of the UPC-A symbol was included in the calibration instructions.
Advanced Options

The Advanced Settings option is to be used only in consultation with a technical support engineer from Webscan. This menu option is password protected and the password is only disclosed to the customer in case technical support feels that there is a need to manually override any of the settings.

Setting the Calibration Values (if necessary)

1. Select ‘Options’ then ‘Advanced Settings’.
2. Enter the values as instructed, and press ‘save’ to save these changes.
Setting Traverse Properties (if necessary)

1. Select ‘Options’ then ‘Advanced Settings’.
2. Enter the Mid. Zone and Z ramp as instructed.
3. Press ‘save’ to save these changes.
Software Upgrades

Software Upgrades are available via e-mail or on-line at www.webscaninc.com. You can also contact Webscan Customer Service to request the upgrade by e-mail.

The simplest option is to go to the Help Menu and select “Update”, if the computer your verifier is installed on has internet access the system will automatically download updates. Updates are not automatically installed and will be placed on your computer desktop for installation at your leisure.
Routine Care and Maintenance

Besides periodic calibration, the TruCheck system requires a minimum amount of care and maintenance. Since the window is located on a bottom facing surface, it is unlikely to become dirty. However, in a very dusty environment, it is necessary to clean the window surface from time to time.

It is recommended that you use a soft cloth, similar to the type used on eye glasses or camera lenses. Warm water may be used along with a gentle cloth. Slowly wipe up and down making sure to clean the entire width of the window.

WARNING!!!

NEVER USE A DETERGENT WITH ANY ABRASIVE CONTENT!

BE CAREFUL TO NOT SCRATCH THE WINDOW!
If You Are Having Trouble with Your TruCheck Laser USB

If you are having trouble with your TruCheck system, please check a few basic things.

1. Reboot the PC. See if this corrects the problem.

2. Make sure the system is not in Negative Mode, unless you are in fact trying to verify a Negative.

3. Calibrate the unit. After calibration, verify the calibration bar code. See if the values given by the system match the values for the Calibration card.

4. Make sure the Calibration symbol is centered when calibrating the symbol.

5. If you are able to receive scan information, but the laser fails to move when expected, make sure that the power is properly connected.

6. If the remote is not detected, unplug the USB connecter from your computer, and plug it into a different USB port. This may help the operating system to identify the device.

7. Make sure that the USB port the remote is connected to supports USB 2.0. It is possible that some but not all USB ports on a computer will support USB 2.0, so if this is suspected to be the case, review your computer’s documentation to identify USB 2.0 ports.

If these actions do not correct the problem please call Webscan Technical support as described below.
If You Need Service

If you need service for your TruCheck system, please call Webscan Technical Support at (303) 485-6811. Please be near the TruCheck system when you call and have your calibration card available. You may be instructed by Webscan to calibrate the system or to go into the Advanced Menu in an effort to find and/or fix the problem. If factory service is required for the system, you will be given RMA # (Return Material Authorization Number) that Webscan will use to track and record service activity.

The address to send equipment to is:

Webscan Inc.
Attn: RMA#_______ (put in your RMA#)
1254 Sherman Drive
Unit #1
Longmont, CO 80501
Tel (303) 485-6811
Fax (303) 485-6353

FCC Class “A” Statement:

This device complies with Part 15 of the FCC rules. Operation is subject to the following two conditions: (1) this device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

Accessories:

Call Webscan Inc. if you need a new Calibration Symbol (Order number 1556).
Uninstalling the Software

TruCheck USB Laser Setup Wizard takes you through removing the software with instructions on every screen.

To uninstall TruCheck USB Laser:

1. Insert the TruCheck USB Laser CD-ROM into the CD-ROM drive. The installation program should start automatically. If it does not start, locate your CD-ROM drive in Windows Explorer and double-click the Autorun.exe program at the top-level of the CD-ROM.

2. Check ‘Remove TruCheckUSB’ and click the ‘Finish’ button in the dialogue box. The Setup Wizard will then uninstall TruCheck USB Laser.
Removing TruCheckUSB

TruCheckUSB is being removed.

Please enter...

Installation Complete

TruCheckUSB has been successfully removed.
Click "Close" to exit.
Appendix A: Compliance Statement

Compliance Statement

Webscan certifies that the TruCheck Laser USB Verifier system complies with the following specifications:

- ISO 15415 with relation to multi-row stacked symbols
- ISO 15416
- ISO 15426-1 and 15426-2
- ANSI X3.182-1990 Bar Code Print Quality – Guideline

Evidence of compliance with the aforementioned standards and traceability to National Institute of Standards and Technology (NIST) is provided through the use of Applied Image Certified Calibrated Conformance Standards which are manufactured to exacting specifications by Applied Image, Inc. for GS1 (formerly The Uniform Code Council.) Webscan tests each unit for conformity within specified tolerances per ISO 15426 parts 1 and 2.

Applied Image certified U.P.C. Calibration Standards are manufactured to Applied Image, Inc. and Uniform Code Council, Inc. specifications, using ANSI X3.182-1990 methodology, and are calibrated using standards traceable to the National Institute of Standards and Technology.
Appendix B: Computer and System requirements for the TruCheck USB Laser

Minimum Hardware Requirements:

• A Windows based PC running a 2.4 GHz CPU with Hyper-Threading Technology

• OR – a multi core processor running at 1.8 GHz or higher

• 1GB RAM minimum, 2 GB RAM recommended

• Hard drive with at least 100 MB free space, recommend 60+ GB hard drive.

• Screen resolution 1024x768 recommended minimum - 800x600 minimum.

• Embedded USB 2.0 (system will not work with USB 1.0 or USB 1.1 or some USB 2.0 add on cards). The TruRemote Laser must be connected directly to a PC USB 2.0 ‘A’ connector, not through a remote hub.

System Requirements:

• Supported Operating Systems:

  • Windows XP with at least SP2 installed. It is recommended that the latest service pack and all critical updates for Windows XP are loaded and configured before installing the Webscan application. Vista and Windows 7 are also compatible.

  • Dot Net 3.5 SP 1 must be installed on the machine

• For Best Performance:

  • Minimize CPU load due to other programs before running the TruCheckUSB software. Other applications such as browsers, e-mail applications, or anti-virus software can consume significant CPU bandwidth.

  • Minimize or eliminate other USB data intensive applications before running the TruCheckUSB software. E.g. applications using USB headphone or video devices.
Appendix C: Engineering Specifications

• **Accuracy to Industry Standards:**
  Accuracy of the optical parameter measurements are to ISO15426 (Bar Code Verifier Conformance Specifications), as follows:

  The arithmetic mean of the measurements on 10 scans on a Primary Reference Test Symbol shall be within, Decodability: ±8%, Rmin: ±3%, Rmax: ±5%, Defect: ±8%, Modulation: ±12% (not specified in ISO15426, but our specified tolerance)

  Note: Refer to Section 2 of ISO15426.

  Note that the units of the tolerance are percentage of 100%, in other words reported units, not percentage of the reading. Example: For a Test Symbol with decodability of 88%, a reading in the range 80% through 96% is within these tolerances. Note that in most cases, measurements are more accurate than those stated above.

• **Resolution and Range:**
  a. Final Quality Grade: Scale of 0.0 to 4.0, to a resolution of 0.1. Reported also as letter grade as follows:

             | Final Grade Value | Letter Grade |
       ---|-------------------|-------------|
          | ≥3.5              | A           |
          | ≥2.5 and < 3.5    | B           |
          | ≥1.5 and < 2.5    | C           |
          | ≥0.5 and < 1.5    | D           |
          | < 0.5             | F           |

  b. Individual Parameters: Reported on a scale of 0 to 100 with resolution of 1. Note that the resolution of measurement is not an indication of accuracy.

• **Calibration to Industry Standards**
  Refer to section 6.2 of ISO15426.

  All TruCheck models have a means of calibrating reflectance values against reference reflectance calibration samples. Two calibration points are used, one near the high reflectance end of the range and the other near the low reflectance end of the range. The reflectance calibration target specified by Webscan is the UCC Calibrated Conformance Standard. This NIST traceable standard is a product of the Uniform Code Council (UCC), and is available through Webscan, Inc. or from the UCC directly (www.uc-council.org).

  The calibration procedure specified by Webscan, Inc. is documented in the User Manual.

• **Environmental**
  Temperature 0-40 C, Humidity: 5% - 95% non-condensing
Appendix D: Symbology specific information

The following is a list of current symbologies supported by the TruCheck Laser USB. Note that there are a number of 2D symbologies that are not supported by the TruCheck laser USB, but are supported by the TruCheck camera USB. Please contact Webscan for ordering information if 2D symbologies are to be verified.

- **UPC**
  - **UPCA:**

![UPC Code](image)

UPC Supplemental:
UPC symbols are non-stacked, and linear. In order to verify a UPC symbol that has supplemental content, be checked in the settings menu. (If it is not, the supplemental content will be ignored.)

- **EAN**
  - EAN13:
EAN8:

EAN symbols are non-stacked, and linear. EAN symbols closely resemble UPC symbols, so make a note of the “symbology” field after a verification to differentiate between the two.

- **Code 128**
  Code 128:

Code 128 symbols are linear, and non-stacked. They are encoded according to a specialized coding scheme, which has 3 character sets. These character sets are known as “A”, “B”, and “C” and each mode assigns different meanings to the codewords present in the symbol. The data detail tab will show in what character set the symbol was encoded, and when and if the character set was changed partway through the symbol.

Code 128 symbols closely resemble Code 39 symbols and Code 93 symbols, so make a note of the “symbology” field after a verification to differentiate between them.
• **Code 39**
  
  Code 39:

  ![Code 39 Image](image)

  Code 39 is linear, and non-stacked. They closely resemble Code 128 symbols and Code 93 symbols, so make a note of the “symbology” field after a verification to differentiate between them.

• **TLC 39**
  
  TLC 39:

  ![TLC 39 Image](image)

  TLC 39 is a linear, non-stacked symbology.
• **I 2 of 5**  

I 2 of 5:

Interleaved 2 of 5 is a continuous two-width barcode symbology, and it is both linear and non-stacked. ITF 14 is a GS1 form of I 2 of 5, and the TruCheck USB Laser software will evaluate symbols encoded according to selected standards, either I 2 of 5 standard, or GS1 – ITF14. In order to select which standard is applied, there is a drop down menu box in the decode options of the settings window.

• **I 2 of 5**  

CODABAR:

Codabar symbols are linear and non-stacked.
- **Code 93**
  Code 93:
  ![Code 93 Example](image1)

  Code 93 symbols are linear and non-stacked. They closely resemble Code 128 symbols and Code 39 symbols, so make a note of the “symbology” field after a verification to differentiate between them.

- **Pharmacode**
  Pharmacode (small number):
  ![Pharmacode (small number)](image2)

  Pharmacode (larger number):
  ![Pharmacode (larger number)](image3)
Pharmacode symbols are linear and non-stacked. By default, the TruCheck verifier will not detect Pharmacode symbols, so if Pharmacode symbols are to be verified, there is an option in the “type of code” section of the settings menu that must be checked. It is recommended that you activate this setting only when needed, because stray marks and other types of symbols can sometimes have the proper spacing to qualify as a valid Pharmacode symbol. This issue can be avoided by turning off Pharmacode whenever Pharmacode symbols are not being verified.

The data in a Pharmacode symbol is reported twice, in both the data field of the main screen, as well as the data detail tab. The first is indicated by an “F:”, expressing the data as interpreted by a foreword scan. The second is indicated by an “R:”, indicating the data as interpreted by a reverse scan.

- **RSS**
  - RSS14:

![RSS14](image)

  RSS14 Limited:

![RSS14 Limited](image)

  RSS14 Stacked:

![RSS14 Stacked](image)
RSS is a stacked linear symbology. Even RSS symbols that have only 1 linear component should be treated as stacked symbols for the purposes of setting up a scan region. RSS symbols will not be detected by default, so “RSS \ Linear” in the “type of code” section of the settings menu must be checked in order to verify RSS codes. The “# of scans” option in the settings menu has no effect on RSS symbols; the appropriate number of scans will be decoded according to the technical specifications.

The reporting for RSS symbols is different than other symbologies when there is more than one component. Each component has its own grade. The grade of each component will affect the grade for the whole symbol, where the overall symbol grade is the lowest grade scored by any of its components.

It is important to note that there is a special flag inside the data of RSS codes that identifies the presence of a secondary component. If this flag is set improperly, the grade for the symbol is reported as “F” even if all other parameters receive high grades. This is reported as “link flag set, but composite component not found” in the primary report.
• **PDF417**

PDF417 (standard):

PDF417 Truncated:

PDF417 is a stacked linear symbology. In order to verify PDF417 symbols, “PDF” must be selected in the “type of Code” section of the settings menu.

Many PDF 417 symbols are larger in size than the opening in the “E” guide plate (this is the default guide plate shipped with 6mil laser remotes). To scan these large symbols with a 6 mil remote, a guide plate with a larger opening is needed. A “D” guide plate is available; this guide plate has a 5” opening and can accommodate many symbols too large to be scanned with the “E” guide plate.

• **Micro PDF**

uPDF (1 column):
Micro PDF (often abbreviated uPDF) is a linear stacked symbology. “uPDF” must be selected in the “type of code” section of the settings menu in order to verify micro PDF symbols. It is possible for an RSS composite symbol to contain a uPDF symbol as one of its components. To verify this type of symbol, “RSS \ linear” must be selected, and “uPDF” need not.
Appendix E: Laser Safety and FCC Compliance Information

**CDRH Compliance Statement**
The Webscan TruCheck Bar Code Verifier complies with standard 21CFR1040.10. Caution - use of controls or adjustments or performance of procedures other than those specified herein may result in hazardous laser light exposure. The type and location of warning labels that comply with the CDRH standard are illustrated below:

The label below is located underneath the laser housing on Models 101/201, and on the side of the Remote scanner on the 101R/201R and indicates the location of the aperture:

AVOID EXPOSURE - Laser light is emitted from this aperture

The label below is located on the bottom of the unit and indicates the Model Number and Date of Manufacture:

<table>
<thead>
<tr>
<th>Model#</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manufactured</td>
</tr>
<tr>
<td>Serial#</td>
</tr>
<tr>
<td>Webscan, Inc.</td>
</tr>
<tr>
<td>1254 Sherman Dr. Unit#1</td>
</tr>
<tr>
<td>Longmont, CO 80501</td>
</tr>
</tbody>
</table>

The label below indicates that this product is a Class II laser device and contains the FDA Class II Warning logotype:

![CAUTION Laser Light Do Not Stare Into Beam]

630 - 680nm LASER
1.0 MILLIWATT
MAXIMUM OUTPUT
CLASS II LASER PRODUCT
The label below contains the FCC Compliance Statement, the CDRH Compliance Statement and the caution statement for protective housings without interlocks.

This equipment complies with Part 15 of the FCC rules. Operation is subject to the following two conditions: (1) This device may not cause harmful interference, and (2) This device must accept any interference received including interference that may cause undesired operation.

Complies with 21CFR1040.10
CAUTION - Laser light when open. DO NOT STARE INTO BEAM.